# Table of Contents

## Introduction 7

### Part 1: Planning your installation

**Chapter 1:** Components used by IBM Cognos Business Viewpoint Server 9  
  Components installed with IBM Cognos Business Viewpoint Server 9  
  Components not installed with IBM Cognos Business Viewpoint Server 10

**Chapter 2:** Installation and testing checklist for IBM Cognos Business Viewpoint 11

**Chapter 3:** Distribution options for IBM Cognos Business Viewpoint Server 13  
  IBM Cognos Business Viewpoint Server and database server on one computer 13  
  IBM Cognos Business Viewpoint Server and database server on separate computers 14  
  Integration with IBM Cognos Business Intelligence 15

**Chapter 4:** Installation requirements to move fact data into IBM Cognos TM1 17

**Chapter 5:** Setting up your environment 19  
  Reviewing the release notes before you install 19  
  Reviewing supported environments 19  
  Verifying system requirements 20  
  Creating the IBM Cognos Business Viewpoint repository 21  
    Creating the IBM Cognos Business Viewpoint repository in IBM DB2 21  
    Creating the IBM Cognos Business Viewpoint repository in Microsoft SQL Server 23  
    Creating the IBM Cognos Business Viewpoint repository in Oracle 24  
  Configuring web browsers 26

### Part 2: Installation and configuration of IBM Cognos Business Viewpoint Server

**Chapter 6:** Installing and configuring IBM Cognos Business Viewpoint Server 29  
  Setting your JAVA_HOME variable 29  
  Installing IBM Cognos Business Viewpoint Server 30  
  Configuring IBM Cognos Business Viewpoint Server 32  
    Specifying a connection to a mail server account 34  
    Testing the IBM Cognos Business Viewpoint Server configuration 34  
    Creating a data source in the IBM Cognos Business Intelligence environment 35  
    Configuring IBM Cognos Software Development Kit to run IBM Cognos Business Viewpoint tasks 36

**Chapter 7:** Configuring IBM Cognos Business Viewpoint Server to use an authentication provider 37  
  Configuring IBM Cognos Business Viewpoint Server to use Active Directory Server 37  
  Configuring an Active Directory namespace 38  
  Including or excluding domains by using advanced properties 38  
  Configuring IBM Cognos Business Viewpoint Server to use LDAP 39  
  Configuring an LDAP namespace 40  
  Configuring an LDAP namespace for Active Directory Server 41  
  Replace Operation 43

Licensed Materials – Property of IBM  
<table>
<thead>
<tr>
<th>Appendix D: Keyboard Shortcuts in the Installation Wizard</th>
<th>79</th>
</tr>
</thead>
<tbody>
<tr>
<td>Index</td>
<td>81</td>
</tr>
</tbody>
</table>
IBM® Cognos® Business Viewpoint allows business and financial analysts the ability to maintain, govern, and share the dimensions and hierarchies that the business uses to drive performance.

This document includes the information that you need to install Business Viewpoint Server.

Audience
This document is intended to help system administrators and information technology specialists install Business Viewpoint Server.

Finding information
To find IBM® Cognos® product documentation on the web, including all translated documentation, access one of the IBM Cognos Information Centers at http://publib.boulder.ibm.com/infocenter/cogic/v1r0m0/index.jsp. Updates to Release Notes are published directly to Information Centers. You can also read PDF versions of the product release notes and installation guides directly from IBM Cognos product disks.

Accessibility Features
Accessibility features help users who have a physical disability, such as restricted mobility or limited vision, to use information technology products. The installation wizard has accessibility features. For information on these features, see "Keyboard Shortcuts in the Installation Wizard" (p. 79).

Forward-looking statements
This documentation describes the current functionality of the product. References to items that are not currently available may be included. No implication of any future availability should be inferred. Any such references are not a commitment, promise, or legal obligation to deliver any material, code, or functionality. The development, release, and timing of features or functionality remain at the sole discretion of IBM.

Samples disclaimer
The Great Outdoors Company, GO Sales, any variation of the Great Outdoors name, and Planning Sample depict fictitious business operations with sample data used to develop sample applications for IBM and IBM customers. These fictitious records include sample data for sales transactions, product distribution, finance, and human resources. Any resemblance to actual names, addresses, contact numbers, or transaction values is coincidental. Other sample files may contain fictional data manually or machine generated, factual data compiled from academic or public sources, or data used with permission of the copyright holder, for use as sample data to develop sample applications. Product names referenced may be the trademarks of their respective owners. Unauthorized duplication is prohibited.
Introduction
Chapter 1: Components used by IBM Cognos Business Viewpoint Server

IBM® Cognos® Business Viewpoint Server renders the IBM Cognos Business Viewpoint Studio interface. IBM Cognos Business Viewpoint Server runs requests to the database and connects to other IBM Cognos components. IBM Cognos Business Viewpoint Studio is a Web-based tool that gives business and financial analysts the ability to create, maintain, govern, and share the dimensions and hierarchies that the business uses to drive performance.

You can leverage the security that is already configured in an existing IBM Cognos environment and apply it to IBM Cognos Business Viewpoint Server.

Components installed with IBM Cognos Business Viewpoint Server

The following components are installed automatically when you install IBM® Cognos® Business Viewpoint Server.

**Tomcat Application Server**

Apache Tomcat is the application server that IBM Cognos Business Viewpoint Server uses to serve dynamic content. Tomcat is also a Web server that serves static Web content; because of this, a separate Web Server component is not installed with IBM Cognos Business Viewpoint Server. You can choose to run IBM Cognos Business Viewpoint within IBM WebSphere® Application Server instead.

**IBM Cognos Business Viewpoint Server**

IBM Cognos Business Viewpoint Server renders the IBM Cognos Business Viewpoint Studio interface. It runs requests to the database and connects to other IBM Cognos components.

**IBM Cognos Configuration**

IBM Cognos Configuration configures IBM Cognos Business Viewpoint. It also allows you to start and stop its services.

**IBM Cognos Business Viewpoint Studio**

IBM Cognos Business Viewpoint Studio is a Web-based tool that business and financial analysts use to create, maintain, govern, and share the dimensions and hierarchies that the business uses to drive performance.
Components not installed with IBM Cognos Business Viewpoint Server

The following components are not installed when you install IBM® Cognos® Business Viewpoint Server.

**IBM Cognos Connection**
IBM Cognos Connection is a Web portal provided with IBM Cognos Business Intelligence (BI). It provides a single point of entry for querying, analyzing, and organizing data, and for creating reports, scorecards, and events. Users can run all their Web-based IBM Cognos applications through IBM Cognos Connection. IBM Cognos Connection can integrate other business intelligence applications and URLs to other applications.

IBM Cognos BI can be configured to allow IBM Cognos Business Viewpoint Studio users to publish packages to IBM Cognos Connection.

**IBM Cognos Business Viewpoint Client**
Using IBM Cognos Business Viewpoint Client, business users can transfer data between IBM Cognos Business Viewpoint Studio and other applications, such as IBM Cognos Planning - Analyst or IBM Cognos TM1®.

For more information, see the IBM Cognos Business Viewpoint Client *Installation and Configuration Guide*.

**IBM Cognos Business Viewpoint for Microsoft Excel**
IBM Cognos Business Viewpoint for Microsoft® Excel lets you download data from IBM Cognos Business Viewpoint Studio to Microsoft Excel, manipulate the data, and then return it to IBM Cognos Business Viewpoint Studio.

For more information, see the IBM Cognos Business Viewpoint for Microsoft Excel *Installation and Configuration Guide*.

**IBM Cognos Data Manager Runtime**
IBM Cognos Data Manager Runtime allows you to move data between products. For example, to move fact data to IBM Cognos TM1 or to source data from other IBM Cognos packages.

For more information, see "Installation requirements to move fact data into IBM Cognos TM1" (p. 17).

If you already have a supported version of Data Manager, you can use that version. If not, use the Data Manager Runtime installer that is provided with Business Viewpoint.
Use the following checklist to ensure that you install and test the IBM® Cognos® Business Viewpoint features that you want to deploy.

- Prepare for implementation.
  
  This task is usually performed by a team that is assembled and led by the performance management solutions architect. IBM Cognos Business Viewpoint implementation will install and configure it to integrate effectively with your existing infrastructure. To ensure that IBM Cognos Business Viewpoint is implemented effectively, do the following:
  
  - Consider your distribution options. For more information, see "Distribution options for IBM Cognos Business Viewpoint Server" (p. 13).
  
  - Set up your environment. This involves reviewing the supported environments, verifying the system requirements, and setting up your database. For more information, see "Setting up your environment" (p. 19).

- Install and configure IBM Cognos Business Viewpoint Server.

  This task is usually performed by a system administrator or information technology consultant. You can install the server software in one of two ways:

  - You can run the installation wizard, choosing options as you go. For more information, see "Installing IBM Cognos Business Viewpoint Server" (p. 30).

  - You can set up and run an unattended installation. This non-interactive method of installing and configuring IBM Cognos Business Viewpoint Server has all the tasks run automatically. You can run the unattended installation as part of a script, or from the command line. For more information, see "Setting up an unattended installation and configuration" (p. 67).

- Create a data source in the Business Intelligence environment. This is optional.

  This enables publishing packages from IBM Cognos Business Viewpoint to IBM Cognos BI. For more information, see "Creating a data source in the IBM Cognos Business Intelligence environment" (p. 35).

- Test that a IBM Cognos Business Viewpoint Studio user can publish packages to IBM Cognos BI. This is optional.

  For more information, see the IBM Cognos Business Viewpoint Studio User Guide.

- Configure IBM Cognos Software Development Kit to run IBM Cognos Business Viewpoint tasks. This is optional.

  You can enable IBM Cognos Software Development Kit users to create scripts that run IBM Cognos Business Viewpoint tasks automatically. For more information, see "Configuring IBM Cognos Software Development Kit to run IBM Cognos Business Viewpoint tasks" (p. 36).
Test that the IBM Cognos BI Software Development Kit configuration was successful. This is optional. For more information, see the IBM Cognos Software Development Kit Developer Guide.

Set up and maintain security.

You can either use the authentication that is configured in an existing Business Intelligence environment, or you can use Cognos Access Manager (CAM) that is included on the IBM Cognos Business Viewpoint installation CD.

To set up security in IBM Cognos Business Viewpoint, use IBM Cognos Business Viewpoint Studio to change the credentials for the "admin" user, specify the system on which users are authenticated, and create and manage both IBM Cognos Business Viewpoint users and external users. For more information, see the IBM Cognos Business Viewpoint Studio User Guide.

Test that you successfully set up security.

To test that IBM Cognos Business Viewpoint security was set up successfully, see the IBM Cognos Business Viewpoint Studio User Guide.

Install and configure IBM Cognos Business Viewpoint Client.

Install and configure IBM Cognos Business Viewpoint Client to enable external IBM Cognos applications to interoperate with IBM Cognos Business Viewpoint Studio. For installation information, see the IBM Cognos Business Viewpoint Client Installation and Configuration Guide.

Test the configuration of IBM Cognos Business Viewpoint Client.

To test that the configuration was successful, see the IBM Cognos Business Viewpoint Client Installation and Configuration Guide.

Install and configure IBM Cognos Business Viewpoint for Microsoft® Excel.

For information about how install and configure IBM Cognos Business Viewpoint for Microsoft Excel, see the IBM Cognos Business Viewpoint for Microsoft Excel Installation and Configuration Guide.

Test the configuration of IBM Cognos Business Viewpoint for Microsoft Excel.

To test the configuration of IBM Cognos Business Viewpoint for Microsoft Excel, see the IBM Cognos Business Viewpoint for Microsoft Excel Installation and Configuration Guide.
Chapter 3: Distribution options for IBM Cognos Business Viewpoint Server

When you install IBM® Cognos® Business Viewpoint Server, all IBM Cognos Business Viewpoint Server components are installed on one computer. You can install these components using any of these options:

- Install and configure IBM Cognos Business Viewpoint Server and the database server on one computer.
  Use this option for a demonstration or in a proof of concept environment.

- Install and configure IBM Cognos Business Viewpoint Server and the database server on separate computers.
  Use this option when a different functional group manages the database server.

- Choose one of the first two options, then configure an existing IBM Cognos Business Intelligence (BI) server to connect to the IBM Cognos Business Viewpoint database.
  Use this option if IBM Cognos Business Viewpoint users want to publish packages to an IBM Cognos BI server, import packages from IBM Cognos BI, or add external users to IBM Cognos Business Viewpoint Studio.

IBM Cognos Business Viewpoint Server and database server on one computer

You can install IBM® Cognos® Business Viewpoint Server and the database server on one computer. Choose this scenario for proof of concept or demonstration environments where the user load is small.

In the following diagrams, one installation shows the IBM Cognos Business Viewpoint Client, IBM Cognos Business Viewpoint Server, the Tomcat or Websphere application server, and the database server containing the IBM Cognos Business Viewpoint repository all on one computer. The other installation shows the IBM Cognos Business Viewpoint Client installed on a separate computer.
Configuration requirements

If you install IBM Cognos Business Viewpoint Server and the database on the same computer, you must then do the following:

- Specify connection information, including the server name, to the IBM Cognos Business Viewpoint repository.
- Configure a mail server to send notifications (if required). For more information, see "Specifying a connection to a mail server account" (p. 34).

IBM Cognos Business Viewpoint Server and database server on separate computers

The IBM® Cognos® Business Viewpoint repository can reside on the same computer as IBM Cognos Business Viewpoint Server or on a different one.

If you install the database on a different computer than IBM Cognos Business Viewpoint Server, you free up processing power IBM Cognos Business Viewpoint Server can use. This also allows a different functional group to manage the database server.

In the following diagram, IBM Cognos Business Viewpoint Server and the Tomcat or Websphere application server are installed on one computer and the database is installed on a second computer.
**Configuration requirements**

If you install IBM Cognos Business Viewpoint Server and the database on separate computers, you must then do the following:

- Specify connection information, including the server name, to the IBM Cognos Business Viewpoint repository.

- Configure a mail server to send notifications (if required). For more information, see "Specifying a connection to a mail server account" (p. 34).

**Integration with IBM Cognos Business Intelligence**

IBM® Cognos® Business Viewpoint allows business users to share and manage dimensional data between different IBM Cognos products, such as IBM Cognos BI. You can integrate your IBM Cognos Business Viewpoint environment with an IBM Cognos BI environment by doing the following:

- Enabling the importing and publishing of packages

- Applying IBM Cognos security

**Enabling the importing and publishing of packages**

You can allow IBM Cognos Business Viewpoint users to both import packages from, and publish packages to a IBM Cognos BI environment. You do this by configuring the Business Intelligence server to connect to the IBM Cognos Business Viewpoint database. For information, see "Creating a data source in the IBM Cognos Business Intelligence environment" (p. 35).

**Applying IBM Cognos security**

You can use IBM Cognos BI security to authenticate IBM Cognos Business Viewpoint users.

For more information about IBM Cognos Business Viewpoint administrative tasks, see the IBM Cognos Business Viewpoint Studio User Guide.
Integrating with other IBM products

You can also integrate your IBM Cognos Business Viewpoint environment with several other IBM products, such as IBM Cognos Planning - Analyst and IBM InfoSphere™ Master Data Management Server, as well as csv files and relational data sources.

For more information, see the IBM Cognos Business Viewpoint Client Installation and Configuration Guide.
In IBM® Cognos® Business Viewpoint, you can move fact data into IBM Cognos TM1® from a number of external data applications, including other IBM Cognos TM1 servers. This capability allows users to easily bring in information that is critical to being able to fully define their business view for planning and analysis.

To be able to move fact data into TM1, you must have the following versions of software installed:

- At a minimum, you must have IBM Cognos TM1 version 9.4.1 with Fix Pack 3 and hotsite 5.
- The TM1 client installed on the same computer as you have Business Viewpoint Server installed.

To be able to source data from IBM Cognos packages, you must have the following versions of software installed:

- At a minimum, you must have IBM Cognos BI version 8.4.1 with Fix Pack 2.
- A version of IBM Cognos Data Manager that is compatible with your installation of IBM Cognos BI. IBM Cognos Data Manager must be a minimum of version 8.4.1 with Fix Pack 2. Also, install any available hotsite updates.
  
  Data Manager must be installed in the same location as your IBM Cognos BI servers.

- The TM1 client installed on the same computer as you have Data Manager installed.

You must have Business Viewpoint Server and the Data Manager Runtime component installed on computers running the Microsoft® Windows® operating system. You cannot move fact data if one of both of these components are running on UNIX® or Linux® operating systems.

If you already have a supported version of Data Manager, you can use that version. If not, use the Data Manager Runtime installer that is provided with Business Viewpoint.

**Note:** While you can have a different version of the TM1 client than you have of the TM1 server, the TM1 client must be the same or an earlier version than you have of the TM1 server. You cannot use a later version of the TM1 client than you have of the TM1 server to use it with Business Viewpoint.

**Configuration requirements**

To use Business Viewpoint with TM1, you must install the TM1 client on the computers with your other components.

In the following diagram, the TM1 client is installed on the computer with Business Viewpoint Server and on the computer with IBM Cognos BI and Data Manager.
Chapter 4: Installation requirements to move fact data into IBM Cognos TM1
Chapter 5: Setting up your environment

Before you install IBM® Cognos® Business Viewpoint Server you must review requirements and set up resources in your environment so that the components can operate.

Use the following checklist to guide you through the setup process:

☐ Review the Release Notes for late-breaking issues. For more information, see "Reviewing the release notes before you install" (p. 19).

☐ Review an up-to-date list of environments that are supported by IBM Cognos products. For more information, see "Reviewing supported environments" (p. 19).

☐ Check the minimum hardware and software requirements to install and run IBM Cognos Business Viewpoint Server. For more information, see "Verifying system requirements" (p. 20).

☐ Create a relational database for IBM Cognos Business Viewpoint Server to use as a repository. For more information, see "Creating the IBM Cognos Business Viewpoint repository" (p. 21).

☐ Configure the Web browsers. For more information, see "Configuring web browsers" (p. 26).

Reviewing the release notes before you install

Before you install IBM® Cognos® Business Viewpoint Server, you must be aware of all issues that may affect your installation strategy.

Review the release notes before you install the product. The release notes contain information about known issues and documentation updates and deprecation notices. The release notes are available from the first page of the installation wizard or from the product CD.

Reviewing supported environments

To ensure that your product works properly, apply all of the minimum required operating system patches and only use the supported versions of other software with IBM® Cognos® Business Viewpoint.

To review an up-to-date list of environments supported by IBM Cognos products, including information on operating systems, patches, and browsers, visit the IBM Cognos Resource Center (http://www.ibm.com/software/data/cognos/customercenter/).

Note: There are many available versions of the Linux® operating system that support many hardware platforms. Ensure that the IBM Cognos products support the operating system and hardware combination that you are using.
## Verifying system requirements

Use the following table to check the minimum hardware and software requirements to install and run IBM® Cognos® Business Viewpoint Server. You may require additional resources for distributed or production environments.

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating system</td>
<td>Microsoft® Windows®</td>
</tr>
<tr>
<td></td>
<td>UNIX®</td>
</tr>
<tr>
<td></td>
<td>Linux®</td>
</tr>
<tr>
<td>RAM</td>
<td>Minimum: 2 GB</td>
</tr>
<tr>
<td>Operating system specifications</td>
<td>File descriptor limit set to 2048 on UNIX and Linux</td>
</tr>
<tr>
<td>Disk space</td>
<td>A minimum of 2.5 GB of free space is required to install the software and 4 GB of free space on the drive that contains the temporary directory used by IBM Cognos components. For all databases, the size will increase over time. Ensure that you have sufficient disk space for future requirements.</td>
</tr>
<tr>
<td>Java™ Runtime Environment (JRE)</td>
<td>An IBM JRE is installed automatically with IBM Cognos Business Viewpoint Server on Windows.</td>
</tr>
<tr>
<td>Database</td>
<td>You must have one of the following databases available to store IBM Cognos Business Viewpoint data:</td>
</tr>
<tr>
<td></td>
<td>• IBM® DB2® UDB 9.5 or 9.7</td>
</tr>
<tr>
<td></td>
<td>• Oracle 10g or 11g</td>
</tr>
<tr>
<td></td>
<td>• Microsoft SQL Server 2005 or 2008</td>
</tr>
<tr>
<td></td>
<td>TCP/IP connectivity is required for all database types.</td>
</tr>
<tr>
<td>Web browser</td>
<td>For all Web browsers, the following are enabled:</td>
</tr>
<tr>
<td></td>
<td>• cookies</td>
</tr>
<tr>
<td></td>
<td>• JavaScript</td>
</tr>
<tr>
<td></td>
<td>For Microsoft Internet Explorer only, the following are enabled:</td>
</tr>
<tr>
<td></td>
<td>• Run ActiveX controls and plug-ins</td>
</tr>
<tr>
<td></td>
<td>• Script ActiveX controls marked safe for scripting</td>
</tr>
<tr>
<td></td>
<td>• Active scripting</td>
</tr>
</tbody>
</table>
Creating the IBM Cognos Business Viewpoint repository

The IBM® Cognos® Business Viewpoint repository is a relational database that IBM Cognos Business Viewpoint uses to store data.

Before you configure IBM Cognos Business Viewpoint Server, you must create the database. The database type must be one that is listed in the following table:

<table>
<thead>
<tr>
<th>Database Type</th>
<th>Character Encoding</th>
<th>Protocol</th>
</tr>
</thead>
<tbody>
<tr>
<td>IBM® DB2® UDB 9.5 or 9.7</td>
<td>UTF-8</td>
<td>TCP/IP</td>
</tr>
<tr>
<td>Oracle 11g</td>
<td>AL32UTF8 or AL32UTF16</td>
<td>TCP/IP</td>
</tr>
<tr>
<td>Microsoft® SQL Server 2005 or 2008</td>
<td>UTF-8 or UTF-16</td>
<td>TCP/IP</td>
</tr>
</tbody>
</table>

Creating the IBM Cognos Business Viewpoint repository in IBM DB2

If you choose to create an IBM DB2 database for the IBM Cognos Business Viewpoint repository, it must contain the configuration settings shown in the following process.

- Create a database user account on your operating system and name it DMADMIN. Specify that the user password never expires.
  
  **Important:** If the database user account is not named DMADMIN, the IBM Cognos Business Viewpoint Server configuration will fail.

- Add the new user to the DB2ADMS group.

- Add the new user to the DB2USERS group.

- Enable the database to support hierarchical queries.

- Create and name the IBM Cognos Business Viewpoint database, for example, BVSDB. Set the default buffer pool and the default tablespace page size to 32k.
  
  **Tip:** You must remember to set the same name in IBM Cognos Configuration when you configure IBM Cognos Business Viewpoint Server (p. 32).

- Add a schema to the database, and name it DMADMIN. Associate this schema with the DMADMIN user.
  
  **Important:** If the schema is not named DMADMIN, the IBM Cognos Business Viewpoint Server configuration will fail.

- Update the user DMADMIN in the new database and grant all authorities to the user. Ensure that the new user has the following privileges:
Create table spaces for the database:
- A data table space. For example BVS_TS_DATA; Type: Regular.
- A user temporary table space. For example BVS_TS_USER_TEMP; Type: User Temporary.
- If you are also creating a logging database, an additional regular user table space with a page size of 8 KB.
- A system temporary table space. For example BVS_TS_SYS_TEMP; Type: System Temporary.

Update the database logging parameters:
- Set the size of log files to 4096.
- Set the number of primary log files to 20.

If 64-bit library files are set in your environment variables, change the library files used or change the order in which the library files are listed so that the 32-bit library files are listed first.

If you use type 2 UDBC connectivity, set the appropriate environment variables for DB2, which are as follows:

<table>
<thead>
<tr>
<th>Environment variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DB2DIR</td>
<td>The top level directory that contains the database client software or the entire database installation.</td>
</tr>
<tr>
<td>LD_LIBRARY_PATH</td>
<td>The load library path. You must add the driver location.</td>
</tr>
<tr>
<td></td>
<td>For example, LD_LIBRARY_PATH= $DB2_location/sqlib/lib32: $LD_LIBRARY_PATH</td>
</tr>
<tr>
<td></td>
<td>Examples:&lt;br&gt;For the Solaris and Linux® operating systems:</td>
</tr>
<tr>
<td></td>
<td>LD_LIBRARY_PATH= $DB2DIR/lib: $LD_LIBRARY_PATH</td>
</tr>
<tr>
<td></td>
<td>For the AIX operating system:</td>
</tr>
<tr>
<td></td>
<td>LIBPATH=$DB2DIR/lib:$LIBPATH</td>
</tr>
<tr>
<td></td>
<td>For the HP-UX operating system:</td>
</tr>
<tr>
<td></td>
<td>SHLIB_PATH=$DB2DIR/lib:$SHLIB_PATH</td>
</tr>
</tbody>
</table>
Environment variable | Description
--- | ---
DB2INSTANCE | The default database server connection.
DB2CODEPAGE | Setting this optional environment variable to a value of 1208 provides support for multilingual databases. For information about whether to use this environment variable, see the DB2 documentation.

- Use UTF-8 as the code set value when you create the database.

To check if your database has the correct code set, using the command line interface, type the following at the command prompt:

db2 get database configuration for <database_name>

The code set value should be UTF-8, and the code page value should be 1208.

- Ensure that you set the following configuration parameters.

<table>
<thead>
<tr>
<th>Property</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application heap size (applheapsz)</td>
<td>1024 KB</td>
</tr>
<tr>
<td>Lock timeout (locktimeout)</td>
<td>240 seconds</td>
</tr>
</tbody>
</table>

Do not set this to an infinite timeout value.

If the application heap size value is too small, out of memory errors may occur when there are many users.

Creating the IBM Cognos Business Viewpoint repository in Microsoft SQL Server

If you choose to create a Microsoft SQL database for the IBM Cognos Business Viewpoint repository, it must contain the configuration settings shown in the following process.

- Ensure that the collation sequence is not case-sensitive and that the SQL Server is configured for mixed mode authentication. The IBM Cognos Business Viewpoint Server installation uses the locale that the installation program for the collation identifies. You cannot change this setting later.

- Enable TCP/IP network protocol.

- Ensure that SQL Server uses a static port number.

Tip: IBM Cognos Business Viewpoint Server uses a default SQL port number of 1433. If you set a different port number in SQL Server, you must remember to set the same number in IBM Cognos Configuration when you configure IBM Cognos Business Viewpoint Server (p. 32).
Connect to the database engine as a user with administrator privileges.

**Important:** Ensure that you specify that authentication is performed by the SQL Server, not by Windows.

Create the IBM Cognos Business Viewpoint database and give it a name, for example, BVSDB:
- Specify that the initial size of the data file is 2000 MB as a minimum.
- Specify that the initial size of the log file is 200 MB as a minimum.

You must set the same name in IBM Cognos Configuration when you configure IBM Cognos Business Viewpoint Server (p. 32).

Create a SQL Server login name, for example BVSDB:
- Specify that the login password never expires.
- Set the database that you created, for example BVSDB, as the default database.

Create a SQL Server user, for example BVSDB:
- Specify that the new user is an owner of the db_owner schema.
- Specify that the new user has the db_owner role.

Map the new login name to the user name that you created.

### Creating the IBM Cognos Business Viewpoint repository in Oracle

If you choose to create an Oracle database for the IBM Cognos Business Viewpoint repository, it must contain the configuration settings shown in the following process.

Configure the Oracle NLS parameters as shown in the following table:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>NLS_TIMESTAMP_FORMAT</td>
<td>DD-MON-RR HH.MM.SSXFF AM</td>
</tr>
<tr>
<td>NLS_TIME_TZ_FORMAT</td>
<td>HH.MM.SSXFF AM TZR</td>
</tr>
<tr>
<td>NLS_TIMESTAMP_TZ_FORMAT</td>
<td>DD-MON-RR HH.MM.SSXFF AM TZR</td>
</tr>
<tr>
<td>NLS_DUAL_CURRENCY</td>
<td>$</td>
</tr>
<tr>
<td>NLS_NCHAR_CHARACTERSET</td>
<td>AL16UTF16</td>
</tr>
<tr>
<td>NLS_LENGTH_SEMANTICS</td>
<td>BYTE</td>
</tr>
<tr>
<td>NLS_NCHAR_CONV_EXCP</td>
<td>FALSE</td>
</tr>
<tr>
<td>NLS_COMP</td>
<td>BINARY</td>
</tr>
</tbody>
</table>
Create a data tablespace and give it a name, for example BV_DATA_TS.

- Connect to the database as an Administrator.
- Type the following command:
  ```sql
  create tablespace BV_DATA_TS datafile '<datafile path>/bv_data_ts.dbf' size 4g reuse;
  ```
  A tablespace named BV_DATA_TS is created, with size=4 GB.

- Extend the temporary tablespace to 4GB+

- Create a database user:
  - Connect to the database as an Administrator.
  - To create a user and associate it with the tablespace, type the following commands:
    ```sql
    create user BVUSER identified by BVUSER
    default tablespace bv_data_ts
    temporary tablespace temp
    quota unlimited on bv_data_ts;
    ```
    **Note:** Remember to specify the same name when you configure the database in IBM Cognos Configuration.
  - To grant roles and privileges to the user, type the following commands for the BVUSER:
    ```sql
    grant connect, resource to BVUSER;
    grant create job to BVUSER;
    grant create view to BVUSER;
    grant create procedure to BVUSER;
    grant create trigger to BVUSER;
    grant create sequence to BVUSER;
    grant create synonym to BVUSER;
    ```

- Ensure that the parameter for the database instance compatibility level of the IBM Cognos Business Viewpoint database is set to 11g.

  For example, you can check the COMPATIBLE initialization parameter setting by issuing the following SQL statement:
  ```sql
  SELECT name, value, description FROM v$parameter WHERE name='compatible';
  ```
For information about changing an instance configuration parameter, see the Oracle documentation.

☐ Determine if the database is Unicode.

**Tip:** One method is to type the following select statement:

```
select * from NLS_DATABASE_PARAMETERS
```

If the result set returns an NLS_CHARACTERSET that is not Unicode, create a new database and specify AL32UTF8 for the database character set parameters.

☐ Have your database administrator back up the IBM Cognos Business Viewpoint repository regularly because it contains the IBM Cognos data. To ensure the security and integrity of databases, protect them from unauthorized or inappropriate access.

## Configuring web browsers

IBM® Cognos® Business Viewpoint uses the default browser configurations provided by Microsoft® and Mozilla Firefox. For all browsers, ensure that settings are enabled for cookies and Java scripts. Additional required settings are specific to the browser.

IBM Cognos Business Viewpoint supports the following browsers:

- Microsoft Internet Explorer versions 6.x and 7.x
- Mozilla Firefox versions 2.x and 3.x

The following table shows the settings that you must enable in the supported Web browsers for IBM Cognos Business Viewpoint Studio to behave as expected.

<table>
<thead>
<tr>
<th>Browser</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Internet Explorer</td>
<td>Allow Cookies&lt;br&gt;Active Scripting&lt;br&gt;Allow META REFRESH</td>
</tr>
<tr>
<td>Internet Explorer</td>
<td>Run ActiveX controls and plug-ins&lt;br&gt;Script ActiveX controls marked safe for scripting</td>
</tr>
<tr>
<td>Internet Explorer</td>
<td>Binary and script behaviors&lt;br&gt;Allow programmatic clipboard access</td>
</tr>
<tr>
<td>Firefox</td>
<td>Allow Cookies&lt;br&gt;Enable Java&lt;br&gt;Enable JavaScript&lt;br&gt;Load Images</td>
</tr>
</tbody>
</table>
IBM Cognos Business Viewpoint Server uses the cookie JSESSIONID to store a unique user session identifier. The user session identifier is valid for the duration of the browser session.

After upgrading or installing new software, restart the Web browser and advise users to clear their browser cache.
Chapter 6: Installing and configuring IBM Cognos Business Viewpoint Server

This section describes how to install, configure, and test IBM® Cognos® Business Viewpoint Server. It also describes how to configure IBM Cognos Business Intelligence so that you can publish data from IBM Cognos Business Viewpoint Studio to IBM Cognos Business Intelligence.

Do the following:

❑ If you want to use your own JRE or you are installing on UNIX®, you must set your JAVA_HOME variable. For more information, see "Setting your JAVA_HOME variable" (p. 29).

❑ Install IBM Cognos Business Viewpoint Server. For more information, see "Installing IBM Cognos Business Viewpoint Server" (p. 30).

❑ Configure IBM Cognos Business Viewpoint Server. For more information, see "Configuring IBM Cognos Business Viewpoint Server" (p. 32).

❑ Test the configuration to ensure that it is successful. For more information, see "Testing the IBM Cognos Business Viewpoint Server configuration" (p. 34).

❑ If you want to publish data from IBM Cognos Business Viewpoint Studio to IBM Cognos Business Intelligence, enable publishing data. For more information, see "Creating a data source in the IBM Cognos Business Intelligence environment" (p. 35).

❑ If you want IBM Cognos Software Development Kit users to be able to automate IBM Cognos Business Viewpoint tasks, update the configuration of the IBM Cognos Business Intelligence environment. For more information, see "Configuring IBM Cognos Software Development Kit to run IBM Cognos Business Viewpoint tasks" (p. 36).

Setting your JAVA_HOME variable

Set a JAVA_HOME environment variable if one of the following applies to you:

- You are installing on the Microsoft Windows® operating system and you want to use your own JRE but do not already have a JAVA_HOME variable set to that location.

- You are installing on the UNIX® operating system.

Step

- Ensure that the JAVA_HOME environment variable is set to the JRE location.

For example, to set JAVA_HOME to a JRE that you are already using, the path is $JAVA_HOME/bin/jre/version.

Important: The version must be 1.5.0 or higher.
Installing IBM Cognos Business Viewpoint Server

Before you install IBM® Cognos® Business Viewpoint Server, ensure that you have created a server database that will be used by IBM Cognos Business Viewpoint as the data repository.

Steps for the Windows operating system
1. Insert the IBM Cognos Business Viewpoint Server CD or go to the location where the installation files were downloaded and extracted.
2. Double-click issetup.exe.
3. On the Welcome page, click Next.
4. On the IBM License Agreement page, click I accept and click Next.
5. On the Installation Location page, accept or change the default location where IBM Cognos Business Viewpoint Server will be installed and click Next.
   If an IBM Cognos product was already installed in the default location, you must choose a different location.
6. On the Shortcut Folder page, accept or change the default folder where shortcuts to IBM Cognos Business Viewpoint Server will be installed, and click Next.
7. On the Summary page, click Next.
8. On the Finish page, do one or more of the following before clicking Finish:
   - View the transfer log file.
   - View the summary error log file.
   - Choose to view the Release Notes.
   - Choose to start IBM Cognos Configuration.

Steps for UNIX and Linux operating systems
1. On HP-UX, set the _M_ARENA_OPTS environment variable as follows:
   
   _M_ARENA_OPTS 1:4
   
   This increases the memory allocation for HP-UX to more closely match that of other UNIX platforms.
2. If installing from a download, go to the location where the installation files were downloaded and extracted.
3. If installing from a disk, mount the disk using Rock Ridge file extensions.
   To mount the disk on HP-UX, do the following:
   - Add the pfs_mount directory in your path.
     For example,
     
     PATH=/usr/sbin:$PATH
export PATH

- To start the required NFS daemons and run the daemons in the background, type `bg pfs_mountd` and then type `bg pfsd`

- To mount the drive, type

  ```
  pfs_mount -t rrip <device><mount_dir> -o xlat=unix
  ```

  For example,

  ```
  pfs_mount /dev/dsk/c0t2d0 /cdrom -o xlat=unix
  ```

  You can now install or copy files as a non-root user using an IBM Cognos disk from this drive.

- When the installation is complete, type `pfs_umount /cdrom` and kill the pfsd and pfs_mountd daemons to unmount the disk.

4. To start the installation wizard, go to the operating system directory and then type `. /issetup`

   **Note:** When you use the issetup command with XWindows, Japanese characters in messages and log files may be corrupted. When installing in Japanese on UNIX or Linux, first set environment variables `LANG=C` and `LC_ALL=C` (where C is the language code, for example `ja_JP.PCK` on Solaris), and then start the installation wizard.

5. Follow the directions in the installation wizard to copy the required files to your computer.

   Install the components in a directory that contains only ASCII characters in the path name. Some UNIX and Linux Web servers do not support non-ASCII characters in directory names.

6. On the **Finish** page, do one or more of the following before clicking **Finish**:

   - Note the location of the transfer log file.
   - Note the location of the summary error log file.
   - Choose to view the Release Notes.
   - Choose to start IBM Cognos Configuration.

7. Append the `install_location/bin` directory to the appropriate library path environment variable.

   - For Solaris and Linux, `LD_LIBRARY_PATH`
   - For AIX, `LIBPATH`
   - For HP-UX, `SHLIB_PATH`

8. On Linux, set the `PRINTER` environment variable to the name of your printer.
Configuring IBM Cognos Business Viewpoint Server

IBM® Cognos® Business Viewpoint Server installs and uses Tomcat as the application server by default. You can choose to run IBM Cognos Business Viewpoint within IBM WebSphere® Application Server instead. For more information, see "Configuring IBM Cognos Business Viewpoint Server for IBM WebSphere Application Server" (p. 47).

Steps

1. Start IBM Cognos Configuration.
   - To start IBM Cognos Configuration on a Windows® computer,
     From the Start menu, click Programs > IBM Cognos 10 > IBM Cognos Configuration.
   - To start IBM Cognos Configuration on a UNIX® or Linux® computer,
     Go to the install_location/bin directory and then type
     ./cogconfig.sh

2. If you want to change the properties for the Tomcat server, expand Environment, click Tomcat Server, and do one or more of the following:
   - To change the TCP port number on which the Tomcat server listens for client connections, enter a new value in the HTTP/1.1 port number box.
     The port numbers must not be used by any other application that is running on the same computer.
   - To secure the installation, from the Use SSL port box, select True.
   - To change the TCP port number on which the Tomcat server listens for a shutdown request, in the Shutdown port number box, enter a new value.
     The port numbers must not be used by any other application that is running on the same computer.
   - To change the amount of time that a session can be idle before timing out, in the Session timeout box, specify a new time in minutes.

3. If you want to use Cognos Access Manager (CAM) as the system that users are authenticated against, see "Configuring IBM Cognos Business Viewpoint Server to use an authentication provider" (p. 37).

4. If your repository is an IBM DB2® database:
   - Expand Data Access > Business Viewpoint Repository and click Database.
   - In Database server and port number, enter the server name and port number, separated by a colon.
     For example, myserver:50000.
   - In User ID and password, enter the user ID and password for the user who has unrestricted access to the database.
5. If your repository is an Oracle or Microsoft SQL Server database, do the following:
   - Expand Data Access and expand Business Viewpoint Repository.
   - Right-click Database, and then click Delete.
   - Enter a name for the resource, select the type of database, and click OK.
     The name of the resource appears only in IBM Cognos Configuration.
   - In Database server and port number, enter the server name and port number, separated by a colon, of the database computer.
     For example, myserver:1433.
   - In User ID and password, enter the user ID and password for the user who has unrestricted access to the database.
   - In Database name, enter the name of the Oracle or Microsoft SQL Server database.

6. If you want IBM Cognos Business Viewpoint Studio to be able to send tasks by e-mail, specify a connection to a mail server account.
   For more information, see "Specifying a connection to a mail server account" (p. 34).

7. Click File > Save.
   If you are prompted with a message stating that IBM Cognos Configuration cannot obtain a CA certificate from Content Manager, click Yes to allow you to proceed.

8. Expand Environment, right-click Tomcat Server and click Start.
   The following events occur:
   - IBM Cognos Configuration starts the IBM Cognos Business Viewpoint startup script.
   - The startup script registers the Tomcat server as a Windows service.
   - The script starts the Windows service.
   - The IBM Cognos Business Viewpoint server starts.
   - The IBM Cognos Business Viewpoint server connects to the database, and creates the IBM Cognos Business Viewpoint tables.

   If you make additional changes to the configuration, right-click Tomcat Server, click Stop, and then restart the server. You can also stop and restart the IBM Cognos Business Viewpoint service using the Windows services tool.

Specifying a connection to a mail server account

If you want to send tasks by e-mail using IBM Cognos Business Viewpoint Studio, you must configure a connection to a mail server account.

Steps

1. Expand Data Access and click Notification.

2. In the SMTP mail server box, type the host name and port of your SMTP (outgoing) mail server, separated by a colon (:).

3. To change the user name and password, do the following:
   - Click the box next to the Account and password box and then click the edit button.
   - Type the user ID and password in the Value - Account and password dialog box and click OK.

   If logon credentials are not required for the SMTP server, remove the default information for the Account and password box. When you are prompted for confirmation to leave this box blank, click Yes. Ensure that the default user name has been removed. Otherwise, the default account is used and notifications will not work properly.

4. In the Default sender and Default Reply-To Address boxes, type the appropriate values.

If you do not plan to send tasks by email, or do not want to set up a mail server account immediately, you are not required to. However, when you save the configuration and then you start the services in IBM Cognos Configuration, you will see a warning message when the mail server connection is tested. You can safely ignore the warning.

Testing the IBM Cognos Business Viewpoint Server configuration

After you install IBM® Cognos® Business Viewpoint Server, you can test the configuration.

Steps

1. Ensure that the Tomcat service is started.

2. In a browser window, type the URL of IBM Cognos Business Viewpoint Studio:
   
   http://server_name:9410/bv/main.jsp

3. Enter the user name and password for the IBM Cognos Business Viewpoint Administrator account.
Creating a data source in the IBM Cognos Business Intelligence environment

To enable the publishing of data from IBM® Cognos® Business Viewpoint Studio to IBM Cognos Business Intelligence, you must configure the IBM Cognos BI environment. You do this by using IBM Cognos Administration to create a data source named BusinessViewpoint. This data source must reference the same repository that you created earlier in "Creating the IBM Cognos Business Viewpoint repository" (p. 21).

To use IBM Cognos Administration, you must have administrator privileges in the IBM Cognos BI environment.

For more information about data sources, see the IBM Cognos Administration and Security Guide.

Steps

1. In IBM Cognos Connection, in the upper-right corner, click Launch > IBM Cognos Administration.

2. On the Configuration tab, click Data Source Connections.

3. Click the new data source button.

4. In the name and description page, type BusinessViewpoint in the name box and, optionally, a description and screen tip, and then click Next.

   **Important:** You must enter the name BusinessViewpoint. Otherwise, attempts to publish from IBM Cognos Business Viewpoint Studio will fail.

5. In the connection page, from the Type box, select the same type of data source for the repository that you created earlier in "Creating the IBM Cognos Business Viewpoint repository" (p. 21).

6. Specify the isolation level.
   - If the isolation level is unavailable, click Next.
   - If the isolation level is available, select the default object gateway or specify a value, and then click Next.

   For more information about specifying isolation levels, see the IBM Cognos Administration and Security Guide.

7. Specify the connection parameters for the data source.

   For more information, see the IBM Cognos Administration and Security Guide.

8. Click Test the connection, and then Test to test whether parameters are correct.

   In the Status column, you see if the connection was successful. If it was unsuccessful, click Close, return to the previous steps, and verify your connection parameters. If it was successful, go to the next step.

9. Click Finish.

   The new data source is displayed in Data Source Connections on the Configuration tab.
Configuring IBM Cognos Software Development Kit to run IBM Cognos Business Viewpoint tasks

If you want IBM® Cognos® Software Development Kit users to be able to automate IBM Cognos Business Viewpoint tasks, you must update the configuration of the Business Intelligence environment.

If you need to automate IBM Cognos Business Viewpoint tasks, use the IBM Cognos Business Viewpoint Software Development Kit instead of the IBM Cognos Software Development Kit.

Steps

1. Go to the following folder:
   \BI_SDK_installation_location\webapps\p2pd\WEB-INF\classes\n
2. Open the file dimensionManagementService.properties in a text editor.

3. Edit the following properties:
   - \bv.server.host=Business Viewpoint server name
     The default value is localhost
   - \bv.server.port=Business Viewpoint server port
     The default value is 9410
   - \c8.system.name=IBM Cognos system_name
     where IBM Cognos system_name is the name of the Cognos system that was set in IBM Cognos Business Viewpoint Studio. For more information, see the IBM Cognos Business Viewpoint Studio User Guide.

To test the configuration, see the IBM Cognos Software Development Kit Developer Guide.
Chapter 7: Configuring IBM Cognos Business Viewpoint Server to use an authentication provider

This section describes how to configure IBM® Cognos® Business Viewpoint Server with a namespace for the type of authentication provider in your environment. You can configure multiple namespaces for authentication and then have users choose which namespace they want to use when they log in.

IBM Cognos Business Viewpoint Server supports the following types of servers as authentication providers:

- Active Directory Server
- LDAP
- NTLM namespace

Some authentication providers require libraries external to the IBM Cognos Business Viewpoint Server environment to be available. If these libraries are not available on the Linux® operating system, the authentication provider cannot be initialized.

If you want to configure Active Directory Server or NTLM as your authentication source, you must install IBM Cognos Business Viewpoint on a non-Linux computer.

Configuring IBM Cognos Business Viewpoint Server to use Active Directory Server

If you install IBM® Cognos® Business Viewpoint on a Windows® computer, you can configure Active Directory as your authentication source using an Active Directory namespace.

If you install IBM Cognos Business Viewpoint on a UNIX® computer, you must instead use an LDAP namespace to configure Active Directory as your authentication source. If you install IBM Cognos Business Viewpoint on Windows and UNIX computers, you must use an LDAP namespace to configure Active Directory on all IBM Cognos Business Viewpoint computers. When you use an LDAP namespace to authenticate against Active Directory Server, you are limited to LDAP features only. You do not have access to Active Directory features such as advanced properties for domains.

If you install IBM Cognos Business Viewpoint on a Linux® computer, the same restrictions apply as for UNIX. You must use an LDAP namespace to configure Active Directory as your authentication source.

For more information, see "Configuring an LDAP namespace for Active Directory Server" (p. 41).

You cannot connect to the Active Directory Global Catalog, which is a caching server for Active Directory Server. If the connection uses port 3268, you must change it. By default, Active Directory Server uses port 389.
Chapter 7: Configuring IBM Cognos Business Viewpoint Server to use an authentication provider

**Configuring an Active Directory namespace**

You can use Active Directory Server as your authentication provider.

**Steps**

1. Start IBM Cognos Configuration.

2. In the **Explorer** window, under **Security**, right-click **Authentication**, and then click **New resource** > **Namespace**.

3. In the **Name** box, type a name for your authentication namespace.

4. In the **Type** list, click the appropriate namespace and then click **OK**.

5. In the **Properties** window, for the **Namespace ID** property, specify a unique identifier for the namespace.

6. Specify the values for all other required properties to ensure that IBM Cognos Business Viewpoint components can locate and use your existing authentication provider.

7. Specify the values for the **Host and port** property.

   To support Active Directory Server failover, you can specify the domain name instead of a specific domain controller. For example, use mydomain.com:389 instead of dc1.mydomain.com:389.

8. If you want to be able to search for details when authentication fails, specify the user ID and password for the **Binding credentials** property.

   Use the credentials of an Active Directory Server user who has search and read privileges for that server.

9. Click **File** > **Save**.

10. Test the connection to a new namespace. In the **Explorer** window, under **Authentication**, right-click the new authentication resource, and click **Test**.

**Including or excluding domains by using advanced properties**

When you configure an authentication namespace for IBM Cognos Business Viewpoint, users from only one domain can log in. By using the Advanced properties for Active Directory Server, users from related (parent-child) domains and unrelated domain trees within the same forest can also log in.

**Authentication in one domain tree**

If you set a parameter named chaseReferrals to true, users in the original authenticated domain and all child domains of the domain tree can log in to IBM Cognos Business Viewpoint. Users above the original authenticated domain or in a different domain tree cannot log in.
Authentication in all domain trees in the forest

If you set a parameter named MultiDomainTrees to true, users in all domain trees in the forest can log in to IBM Cognos Business Viewpoint.

Steps

1. On every computer where you installed IBM Cognos Business Viewpoint, open IBM Cognos Configuration.
2. In the Explorer window, under Security > Authentication, click the Active Directory namespace.
3. In the Properties window, specify the Host and port property:
   - For users in one domain, specify the host and port of a domain controller for the single domain.
   - For users in one domain tree, specify the host and port of the top-level controller for the domain tree.
   - For users in all domain trees in the forest, specify the host and port of any domain controller in the forest.
4. Click in the Value column for Advanced properties and click the edit button.
5. In the Value - Advanced properties window, click Add.
6. Specify two new properties, chaseReferrals and MultiDomainTrees, with the following values:

<table>
<thead>
<tr>
<th>Authentication for</th>
<th>chaseReferrals</th>
<th>MultiDomainTrees</th>
</tr>
</thead>
<tbody>
<tr>
<td>One domain</td>
<td>False</td>
<td>False</td>
</tr>
<tr>
<td>One domain tree</td>
<td>True</td>
<td>False</td>
</tr>
<tr>
<td>All domain trees in the forest</td>
<td>True</td>
<td>True</td>
</tr>
</tbody>
</table>

7. Click OK.
8. Click File > Save.

Configuring IBM Cognos Business Viewpoint Server to use LDAP

You can configure IBM® Cognos® Business Viewpoint Server to use an LDAP namespace as the authentication provider. You can use an LDAP namespace for users that are stored in an LDAP user directory, Active Directory Server, IBM Directory Server, Novell Directory Server, or Sun Java System Directory Server.

To bind a user to the LDAP server, the LDAP authentication provider must construct the distinguished name (DN). If the Use external identity property is set to True, it uses the External identity
mapping property to try to resolve the user’s DN. If it cannot find the environment variable or the DN in the LDAP server, it attempts to use the User lookup property to construct the DN.

If users are stored hierarchically within the directory server, you can configure the User lookup and External identity mapping properties to use search filters. When the LDAP authentication provider performs searches, it uses the filters you specify for the User lookup and External identity mapping properties. It also binds to the directory server using the value you specify for the Bind user DN and password property or using anonymous if no value is specified.

When an LDAP namespace has been configured to use the External identity mapping property for authentication, the LDAP provider binds to the directory server using the Bind user DN and password or using anonymous if no value is specified. All users who log in to IBM Cognos products using external identity mapping see the same users, groups, and folders as the Bind user.

If you do not use external identity mapping, you can specify whether to use bind credentials to search the LDAP directory server by configuring the Use bind credentials for search property. When the property is enabled, searches are performed using the bind user credentials or using anonymous if no value is specified. When the property is disabled, which is the default setting, searches are performed using the credentials of the logged-on user. The benefit of using bind credentials is that instead of changing administrative rights for multiple users, you can change the administrative rights for the bind user only.

**Important:** If you use a DN syntax, such as `uid=${userID}, ou=mycompany.com`, for the properties User lookup, External identity mapping, or Bind user DN and password, you must escape all special characters that are used in the DN. If you use a search syntax, such as `(uid=${userID})`, for the properties User lookup or External identity mapping, you must not escape special characters that are used in the DN.

### Configuring an LDAP namespace

You can configure IBM Cognos Business Viewpoint Server to use an LDAP namespace when the users are stored in an LDAP user directory. The LDAP user directory may be accessed from within another server environment, such as Active Directory Server or eTrust SiteMinder.

You can also use LDAP authentication with DB2 data sources by specifying the LDAP namespace when you set up the data source connection.

**Steps**

1. Start IBM Cognos Configuration.
2. In the **Explorer** window, under **Security**, right-click **Authentication**, and then click **New Resource > Namespace**.
3. In the **Name** box, type a name for your authentication namespace.
4. In the **Type** box, click the appropriate namespace, and click **OK**.
5. In the **Properties** window, in the **Namespace ID** box, specify a unique identifier for the namespace.
6. Specify the values for all other required properties to ensure that IBM Cognos Business Viewpoint Server can locate and use your existing authentication provider.
Chapter 7: Configuring IBM Cognos Business Viewpoint Server to use an authentication provider

7. If you want the LDAP authentication provider to bind to the directory server using a specific **Bind user DN and password** when performing searches, then specify these values.
   
   If no values are specified, the LDAP authentication provider binds as anonymous.
   
   If external identity mapping is enabled, **Bind user DN and password** are used for all LDAP access. If external identity mapping is not enabled, **Bind user DN and password** are used only when a search filter is specified for the **User lookup** property. In that case, when the user DN is established, subsequent requests to the LDAP server are executed under the authentication context of the end user.

8. If you do not use external identity mapping, use bind credentials for searching the LDAP directory server by doing the following:
   
   - Ensure that **Use external identity** is set to **False**.
   
   - Set **Use bind credentials for search** to **True**.
   
   - Specify the user ID and password for **Bind user DN and password**.
   
   If you do not specify a user ID and password, and anonymous access is enabled, the search is done using anonymous.

9. Check the mapping settings for required objects and attributes.
   
   Depending on the LDAP configuration, you may have to change some default values to ensure successful communication between IBM Cognos Business Viewpoint Server and the LDAP server.
   
   LDAP attributes that are mapped to the **Name** property in **Folder mappings**, **Group mappings**, and **Account mappings** must be accessible to all authenticated users. In addition, the **Name** property must not be blank.

10. Click **File > Save**.

11. Test the connection to a new namespace. In the **Explorer** window, under **Authentication**, right-click the new authentication resource, and click **Test**.

### Configuring an LDAP namespace for Active Directory Server

If you configure a new LDAP namespace for use with an Active Directory Server, you must modify the necessary settings and change the values for all properties of the Active Directory objects.

**Steps**

1. Start IBM Cognos Configuration.

2. In the **Explorer** window, under **Security**, right-click **Authentication**, and then click **New resource > Namespace**.

3. In the **Name** box, type a name for your authentication namespace.

4. In the **Type** list, click the appropriate namespace and then click **OK**.
5. In the **Properties** window, for the **NamespaceID** property, specify a unique identifier for the namespace.
   
   Do not use colons (:) in the Namespace ID property.

6. Specify the values for all other required properties to ensure that IBM Cognos Business Viewpoint Server can locate and use your existing authentication provider.

   The following settings are examples:
   - For User lookup, specify (sAMAccountName=${userID})
   - For Bind user DN and password, specify user@domain
   - For Unique identifier, specify objectGUID

7. If you want the LDAP authentication provider to bind to the directory server using a specific user ID and password when performing searches, then specify these in the **Bind user DN and password** box.

   If no values are specified, the LDAP authentication provider binds anonymously.

8. If you do not use external identity mapping, use bind credentials for searching the LDAP directory server by doing the following:
   - Ensure that Use external identity is set to False.
   - Set Use bind credentials for search to True.
   - Specify the user ID and password for Bind user DN and password.

9. To configure the LDAP advanced mapping properties for use with the Active Directory Server objects, use the values specified in the following table.

   LDAP attributes that are mapped to the **Name** property in **Folder mappings**, **Group mappings**, and **Account mappings** must be accessible to all authenticated users. In addition, the **Name** property must not be blank.

<table>
<thead>
<tr>
<th>Mappings</th>
<th>LDAP property</th>
<th>LDAP value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Folder</td>
<td>Object class</td>
<td>organizationalUnit,organization,container</td>
</tr>
<tr>
<td></td>
<td>Description</td>
<td>description</td>
</tr>
<tr>
<td></td>
<td>Name</td>
<td>ou,o,cn</td>
</tr>
<tr>
<td>Group</td>
<td>Object class</td>
<td>group</td>
</tr>
<tr>
<td></td>
<td>Description</td>
<td>description</td>
</tr>
<tr>
<td></td>
<td>Member</td>
<td>member</td>
</tr>
<tr>
<td></td>
<td>Name</td>
<td>cn</td>
</tr>
<tr>
<td>Mappings</td>
<td>LDAP property</td>
<td>LDAP value</td>
</tr>
<tr>
<td>------------</td>
<td>-----------------</td>
<td>-----------------</td>
</tr>
<tr>
<td>Account</td>
<td>Object class</td>
<td>user</td>
</tr>
<tr>
<td></td>
<td>Business phone</td>
<td>telephonenumber</td>
</tr>
<tr>
<td></td>
<td>Content locale</td>
<td>(leave blank)</td>
</tr>
<tr>
<td></td>
<td>Description</td>
<td>description</td>
</tr>
<tr>
<td></td>
<td>Email</td>
<td>mail</td>
</tr>
<tr>
<td></td>
<td>Fax/Phone</td>
<td>facsimiletelephonenumber</td>
</tr>
<tr>
<td></td>
<td>Given name</td>
<td>givenname</td>
</tr>
<tr>
<td></td>
<td>Home phone</td>
<td>homephone</td>
</tr>
<tr>
<td></td>
<td>Mobile phone</td>
<td>mobile</td>
</tr>
<tr>
<td></td>
<td>Name</td>
<td>displayName</td>
</tr>
<tr>
<td></td>
<td>Pager phone</td>
<td>pager</td>
</tr>
<tr>
<td></td>
<td>Password</td>
<td>unicodePwd</td>
</tr>
<tr>
<td></td>
<td>Postal address</td>
<td>postaladdress</td>
</tr>
<tr>
<td></td>
<td>Product locale</td>
<td>(leave blank)</td>
</tr>
<tr>
<td></td>
<td>Surname</td>
<td>sn</td>
</tr>
<tr>
<td></td>
<td>Username</td>
<td>sAMAccountName</td>
</tr>
</tbody>
</table>

These mapping properties represent changes based on a default Active Directory Server installation. If you have modified the schema, you may have to make additional mapping changes.

10. Click **File > Save**.

11. Test the connection to a new namespace. In the **Explorer** window, under **Authentication**, right-click the new authentication resource, and click **Test**.

**Replace Operation**

The replace operation returns a copy of the string with all occurrences of the old substring replaced by the new substring.

**Notes:**
• The backslash character (\) is used to escape the characters in the function parameters. Characters such as a backslash (\) and a double quotation mark (") need escaping.
• Nested function calls are not supported.
• Special characters are not supported.

Syntax
${replace(str , old , new)}

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>str</td>
<td>The string to search.</td>
</tr>
<tr>
<td>old</td>
<td>The substring to be replaced by the new substring.</td>
</tr>
<tr>
<td>new</td>
<td>The substring that replaces the old substring.</td>
</tr>
</tbody>
</table>

Examples
${replace(${environment("REMOTE_USER")},"NAMERICA\\",)}
${replace(${environment("REMOTE_USER")},"NAMERICA\\"," ")}

Configuring IBM Cognos Business Viewpoint Server to use an NTLM namespace

You can configure IBM® Cognos® Business Viewpoint Server to use the Windows® native security, NT LAN Manager (NTLM), as the authentication source.

If you are not using NTLM in your IS environment, you cannot use an NTLM namespace.

If you want to use an NTLM user directory as your authentication source with eTrust SiteMinder, you must verify the Agent Configuration Object properties in the eTrust SiteMinder Policy Server. Ensure that SetRemoteUser is activated.

Configuring an NTLM namespace

You can configure IBM Cognos components to use an NTLM namespace when users are stored in an NTLM user directory. The NTLM user directory may also be accessed using an eTrust SiteMinder authentication provider.

Steps
1. Start IBM Cognos Configuration.
2. In the Explorer window, under Security, right-click Authentication, and click New resource > Namespace.
3. In the Name box, type a name for your authentication namespace.
4. In the Type list, click NTLM and click OK.

5. In the Properties window, for the NamespaceID property, specify a unique identifier for the namespace.
   Do not use colons (:) in the NamespaceID property.

6. Specify the values for all other required properties to ensure that IBM Cognos components can locate and use your existing authentication provider.

7. Click File > Save.

8. Test the connection to a new namespace. In the Explorer window, under Authentication, right-click the new authentication resource, and click Test.

### Testing the namespaces

After you configure one or more new namespaces for IBM® Cognos® Business Viewpoint Server, you can test the namespaces. The test can occur before or after you start the IBM Cognos Business Viewpoint Server service. You can test all namespaces at the same time or test them individually.

#### Step to test all namespaces

- In the Explorer window, right-click Authentication and click Test.

  IBM Cognos Business Viewpoint Server loads, initializes, and configures the provider libraries for one namespace before testing the next namespace.

  Tip: To cancel a namespace test, click Cancel. The test stops when the current namespace test is complete.

#### Step for a Single Namespace

- In the Explorer window, under Authentication, right-click the new authentication resource, and click Test.

  IBM Cognos Business Viewpoint Server loads, initializes, and configures the provider libraries for the namespace.

### Delete an Authentication Provider

If they are no longer required, you can delete namespaces that you added or unconfigured namespaces that IBM® Cognos® Business Viewpoint Server detected.

**Important:** You must not delete the IBM Cognos Business Viewpoint namespace. It contains authentication data that pertains to all users and is required to save the configuration.

When you delete a namespace, you can no longer log on to the namespace. Security data for the namespace remains in IBM Cognos Business Viewpoint.

#### Steps

1. Start IBM Cognos Configuration.
2. In the Explorer window, under Security > Authentication, right-click the namespace and click Delete.

3. Click Yes to confirm.
   The namespace disappears from the Explorer window and you can no longer log on to the namespace on that computer.

4. Click File > Save.

5. Repeat steps 2 to 4 for each computer where you installed IBM Cognos Business Viewpoint.
Chapter 8: Configuring IBM Cognos Business Viewpoint Server for IBM WebSphere Application Server

IBM® Cognos® Business Viewpoint Server installs and uses Tomcat as the application server by default. You can choose to run IBM Cognos Business Viewpoint within IBM WebSphere™ Application Server instead.

To set up IBM Cognos Business Viewpoint to run on IBM WebSphere Application Server, do the following:

- Create a separate JVM instance, if necessary. For more information, see "Creating a separate JVM instance" (p. 47).
- Check that IBM Cognos Business Viewpoint components are properly set up. For more information, see "Checking the setup of IBM Cognos Business Viewpoint" (p. 48).
- Back up the existing IBM Cognos Business Viewpoint configuration. For more information, see "Backing up the existing IBM Cognos Business Viewpoint configuration" (p. 48).
- Set environment variables. For more information, see "Setting environment variables" (p. 49).
- Configure IBM Cognos Business Viewpoint to run within WebSphere Application Server. For more information, see "Configuring IBM Cognos Business Viewpoint to run within WebSphere Application Server" (p. 50).
- Build the IBM Cognos Business Viewpoint application file. For more information, see "Building the IBM Cognos Business Viewpoint application file" (p. 51).
- Configure the application server properties and deploy IBM Cognos Business Viewpoint. For more information, see "Deploy the IBM Cognos Business Viewpoint application" (p. 52).

Creating a separate JVM instance

To eliminate potential java class or system resource conflicts, IBM® Cognos® Business Viewpoint must be run in a Java™ Virtual Machine (JVM) instance isolated from other existing applications. This ensures that IBM Cognos Business Viewpoint does not affect any existing customer applications. When possible, IBM Cognos Business Viewpoint must be installed in a JVM instance that is separate from the application server admin processes to isolate both IBM Cognos Business Viewpoint and the administrative functions of the application server.

An isolated JVM instance can be established by creating a separate server instance in IBM WebSphere™.
Checking the setup of IBM Cognos Business Viewpoint

Ensure that the following is done before you set up IBM® Cognos® Business Viewpoint to run on the application server:

- The application server is installed and operational on each computer where IBM Cognos Business Viewpoint components are installed.
  
  For more information about installation, see your application server documentation.

- The application server user account has full access permissions for the IBM Cognos Business Viewpoint installation.
  
  Tip: Create a new UNIX® or Linux® group named cognos. This group must contain the user that starts the application server and the user that owns the IBM Cognos files. Change the group ownership of the IBM Cognos files to the cognos group and change the file permissions for all IBM Cognos files to GROUP READABLE/WRITABLE/EXECUTABLE. For simplicity, you can also use the application server user account to install and run IBM Cognos Business Viewpoint components.

Backing up the existing IBM Cognos Business Viewpoint configuration

You must back up the existing IBM® Cognos® Business Viewpoint configuration if IBM Cognos Business Viewpoint components are running on an application server (including Tomcat) and you are changing to an application server that ships with its own JVM. You must also back up existing IBM Cognos Business Viewpoint configuration if you must change the JVM you are using.

Before configuring IBM Cognos Business Viewpoint components to run on the new application server or JVM, you must do the following:

- Back up the configuration information by exporting it. Any encrypted data is decrypted during the export.

- Back up the cryptographic keys by saving them to an alternate location. New cryptographic keys must be created using the same JVM that the application server uses. Because these keys can be created only if the previous keys are deleted, it is important to back up the previous keys.

To ensure the security and integrity of your IBM Cognos Business Viewpoint configuration, back up the configuration information and cryptographic keys to a directory that is protected from unauthorized or inappropriate access.

Tip: To check if any cryptographic keys exist, look in the BusinessViewpoint_location/configuration directory. Cryptographic keys exist if this directory includes the following subdirectories: csk, encryptkeypair or signkeypair.

Steps

1. In IBM Cognos Configuration, click File > Export As and save the configuration information in a decrypted format. When naming the file, use a name such as "decrypted.xml".
Because passwords are stored in plain text, export the data to a directory that is protected from unauthorized or inappropriate access. You are prompted to acknowledge that the export is an unsecure operation.

2. Stop the IBM Cognos Business Viewpoint service:
   - If you use Tomcat, stop the IBM Cognos Business Viewpoint service and close IBM Cognos Configuration.
   - If you use an application server other than Tomcat, shut down IBM Cognos Business Viewpoint in your environment.

3. Back up any existing cryptographic keys by saving the appropriate files and directories to an alternate location that is secure.
   The files are
   - BusinessViewpoint_location/configuration/cogstartup.xml
   - BusinessViewpoint_location/configuration/caSerial
   - BusinessViewpoint_location/configuration/cogconfig.prefs
   - BusinessViewpoint_location/configuration/coglocale.xml
   The directories are
   - BusinessViewpoint_location/configuration/csk
   - BusinessViewpoint_location/configuration/encryptkeypair
   - BusinessViewpoint_location/configuration/signkeypair

4. Delete the caSerial and cogconfig.prefs files and the three directories: csk, encryptkeypair, and signkeypair.

5. Replace the BusinessViewpoint_location/configuration/cogstartup.xml file with the file that contains the data exported from IBM Cognos Configuration (for example, "decrypted.xml").

   **Important:** In the BusinessViewpoint_location/configuration directory, the file must use the name "cogstartup.xml".

   The information in this file will be automatically re-encrypted using new cryptographic keys when you save the configuration in IBM Cognos Configuration.

### Setting environment variables

You must set environment variables to identify the location of the JVM environment and the library path. You can set environment variables using any of the following methods:

- On the Microsoft® Windows® operating system, set a system or user variable, or edit the application server’s startup environment script.

If you set a user variable, ensure that you set it for the user account that will run the application server.
By default, IBM® WebSphere™ Windows service is installed to run under the Local System account. If you update the environment variables or add new environment variables, you must restart the computer before these changes affect the WebSphere service that runs under the Local System account.

- On either the UNIX® and Linux® operating system, set an environment variable in the user profile, or edit the application server’s startup or environment script.

**Tip:** Most WebSphere versions ship with a script specifically intended for setting environment variables. For example, some WebSphere versions ship with setupCmdLine.bat. You can modify this script to set appropriate values for use with IBM Cognos Business Viewpoint components. Most of these scripts set the JAVA_HOME environment variable by default.

**Steps**

1. Set the JAVA_HOME environment variable to point to the JVM used by the application server.
   - If the application server ships with a JVM, then you must set the JAVA_HOME environment variable to reference it.
   - IBM Cognos Configuration uses this variable to create encryption keys, for IBM Cognos Business Viewpoint components, that are compatible with the JVM used by the application server.

2. Append `BusinessViewpoint_location/bin` to the appropriate environment variable.
   - This variable is used to locate the IBM Cognos library files.

<table>
<thead>
<tr>
<th>Operating system</th>
<th>Environment variable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows</td>
<td>PATH</td>
</tr>
<tr>
<td>AIX</td>
<td>LIBPATH</td>
</tr>
<tr>
<td>Solaris and Linux</td>
<td>LD_LIBRARY_PATH</td>
</tr>
<tr>
<td>HP-UX</td>
<td>SHLIB_PATH</td>
</tr>
</tbody>
</table>

**Configuring IBM Cognos Business Viewpoint to run within WebSphere Application Server**

IBM® Cognos® Business Viewpoint must be configured with IBM WebSphere™ application server JVM, and the configuration must be saved to create new cryptographic keys. IBM Cognos Configuration uses the JVM that is defined by the JAVA_HOME environment variable.
Important: To ensure valid encryption keys are generated you must set the JAVA_HOME environment variable to the JVM supplied or used by WebSphere and then copy the security provider files before you run IBM Cognos Configuration.

Steps
1. Start IBM Cognos Configuration:
   - On the Microsoft® Windows® operating system, type `cogconfig.bat` in a command window or select IBM Cognos Configuration from the Start menu.
   - On the UNIX® or Linux® operating system, type `cogconfig.sh`

   If you have existing incompatible encryption keys, you are prompted to automatically generate new ones at this time.

   Tip: Ensure that the existing keys are backed up to a secure location before proceeding. There is no undo action available after you generate new keys.

2. Complete the required configuration changes, such as specifying properties for the IBM Cognos Business Viewpoint repository and entering user IDs and passwords.

3. Save the configuration.

   New cryptographic keys are created using the JVM that is defined by the JAVA_HOME variable.


Building the IBM Cognos Business Viewpoint application file

Use the build application script to create the application file that will be deployed to the IBM® WebSphere™ application server.

Steps
1. Change the current directory to `BusinessViewpoint_location\war\bv`

2. Run the build application script.

   On the Microsoft® Windows® operating system:
   - Run build.bat.

   On the UNIX® operating system:
   - Edit build.sh to set the JAVA_HOME variable.
   - Run build.sh.

3. Verify that `BusinessViewpoint_location\bv.ear` file was build successfully.

   Tip: It is not necessary to rebuild or redeploy the application file when you make configuration changes because configuration information is stored externally to the application.
Deploy the IBM Cognos Business Viewpoint application

You must deploy the IBM® Cognos® Business Viewpoint application file to the IBM® WebSphere™ application server.

**Steps**

1. Start the WebSphere Application Server, and then access the WebSphere Administrative Console.

2. Use the IBM Cognos Business Viewpoint application file (bv.ear) to install a new Enterprise Application.

   You must deploy the application file on the same computer on which you installed IBM Cognos Business Viewpoint.

   For more information on how to deploy an .ear file, see the WebSphere documentation.

   **Important:** You must update the class loader order for the bv.war module.

   IBM Cognos Business Viewpoint enterprise application includes two web modules: 'bv' (bv.war) and 'shared' (shared.war). You must update the class loader order in the 'bv' web module. It is not necessary to update the 'shared' web module.

   By default, WebSphere application server sets the class loader order to parent class loader first and application class loader last. You must change the class loader order to application class loader first and parent class loader last.

   For more information on how to change the class loader order in the web modules of an enterprise application, see the WebSphere documentation.

3. Set the memory used by the JVM.

   Usually, the memory is set by adding or changing the initial and maximum Java heap size. For information about these parameters, see the JVM or application server documentation.

   **Tip:** A minimum of 256 MB and a maximum of 768 MB are suggested starting values. You can change these values to suit your environment.

4. Stop the WebSphere server.

5. Go to the following location:

   `<WebSphere Install Root>/AppServer/profiles/AppSrv01/installedApps/<serverNodeCell>/IBM Cognos Business Viewpoint.ear/bv.war/WEB-INF/classes`

6. Create a file named cogroot.link

7. In the file, add the `<bv install root>` directory path.

8. Save the file.

9. Restart the WebSphere server.

10. Verify that IBM Cognos Business Viewpoint is running by doing the following:

    - In a browser window, type the URL of IBM Cognos Business Viewpoint Studio: `http://server_name:9080/bv/main.jsp`
Use a different port number if you changed the default WebSphere application port.

- Enter the user name and password for the IBM Cognos Business Viewpoint Administrator account.
Chapter 9: Maintaining and Upgrading IBM Cognos Business Viewpoint

This section includes topics about maintaining and upgrading IBM® Cognos® Business Viewpoint.

Optimizing IBM Cognos Business Viewpoint

Over time, the environment for your IBM® Cognos® Business Viewpoint system may change: user populations grow, processing requests increase in number and complexity, and other aspects of infrastructure are modified. These changes can affect performance. As a result, it is important to monitor and tune performance regularly.

Here are some things you can discuss with your database administrator:

- Estimating the number of users you expect to have and when you expect them to use Business Viewpoint Studio.

  Named users is your total user population. Active users is a subset of those who are logged on and can demand system resources. Concurrent users are the ones simultaneously demanding system resources.

  As a general rule, the ratio of named to active to concurrent users for business intelligence applications is about 100:10:1. In other words, for every 1000 named users there are 100 active users and 10 concurrent users.

- Keeping the database tuned and optimized.

  It is important to maintain the performance of your database. If Business Viewpoint Studio demands more of a database than it can provide, you may experience increased response times and degradation in performance and scalability. For information about turning your database, see the documentation for your database.

- Changing memory settings of your application server.

  The memory allocation strategy for your application server depends on the available capacity of your resources, and on the resource needs of other applications running on the server. In general, configure your application server with a minimum of 768 Megabytes of memory for multi-user applications.

  To configure Apache Tomcat or IBM WebSphere®, use IBM Cognos Configuration or alternative methods. If you use an application server other than Tomcat or WebSphere, consult the documentation for that product.
Backing up and restoring data

To migrate data to a different environment or to a new version of IBM® Cognos® Business Viewpoint Studio, administrators can back up the data that is in Business Viewpoint and then restore the data in the different environment or new version.

Some examples are:

- Migrating data from a test environment to a production environment.
- Migrating data from one database platform to a different database platform.
  For example, if you want to move an Oracle repository to IBM DB2®, you back up the data for the Oracle database and restore it using a DB2 database.
- Migrating data from an earlier version of Business Viewpoint to the latest version.

When backing up and restoring data, do the following to ensure that no one uses Business Viewpoint during the backup and restore:

- Stop the Business Viewpoint service.
- Change the port number to a value that no one will know about or use.
- Restart the service.
- Back up or restore the data.
  After restoring the data, you are required to log off. Log in again to verify that your data was restored as expected.
- Stop the Business Viewpoint service and change the port number back to the value that was used previously.
- Restart the Business Viewpoint service.

Alternatively, if your users access Business Viewpoint Studio through a gateway, shut down the gateway before backing up or restoring data.

Backing up the data

Administrators can back up the data that is in Business Viewpoint. For example, you can back up data in a test environment and restore it in a production environment.

You cannot select which data is backed up. All data in the Business Viewpoint repository is backed up.

You cannot schedule when to back up data.

Steps

1. Click Tools > Administration.
2. Click the Backup and Restore tab.
3. Click New Backup.
4. Type a name for the backup file and create a password so that the file is encrypted.

5. To remove a backup file, click the check box next to the backup file and click Remove Backup.

6. Click OK.

The backup file is created in the Migration folder of the Business Viewpoint 10.1 installation.

**Restoring the data**

Administrators can restore the data that they backed up. For example, you can back up data in a test environment and restore it in a production environment.

When you restore data, the contents of the backup file replace all objects in the current Business Viewpoint repository. For example, if you created a Customer dimension in the repository that is not part of the backup file, when you restore the backup file, the Customer dimension is removed along with all other contents.

You cannot schedule when to restore a backup file.

**Steps**

1. Click Tools > Administration.

2. Click the Backup and Restore tab.

3. Select the backup file to restore and click Restore Backup.

   The backup file is in the Migration folder of the Business Viewpoint 10.1 installation.

4. Enter the password.

**Upgrading data from an earlier version of Business Viewpoint**

Administrators can move data from an earlier version of Business Viewpoint to the latest version.

You must have both versions of Business Viewpoint installed to upgrade data.

If you previously published IBM Cognos Business Viewpoint information as IBM Cognos packages, you must republish the packages in the new version of Business Viewpoint.

When migrating data, ensure that no one uses Business Viewpoint during the migration.

**Steps**

1. In Business Viewpoint Studio 8.4.1, create a backup file by doing the following:

   - Click Tools > Administration.

   - Click the Backup and Restore tab.

   - Click New Backup and type a name for the backup file and create a password so that the file is encrypted.

   - Click OK.

2. Exit from Business Viewpoint Studio and stop the Business Viewpoint 8.4.1 service.
3. Install Business Viewpoint 10.1, ensuring that you create a new database during the configuration steps.

   To ensure that no one uses Business Viewpoint during the migration, change the port number for Business Viewpoint to a value that no one will know about or use.

4. Copy the backup file that you created in step 1 to the Migration folder of the Business Viewpoint 10.1 installation.

5. In Business Viewpoint Studio 10.1, restore the backup file by doing the following:
   - Click Tools > Administration.
   - Click the Backup and Restore tab.
   - Select the backup file to restore and click Restore Backup.
   - Enter the password.

6. Stop the Business Viewpoint service and change the port number back to the value that was used previously.

7. Restart the Business Viewpoint service.
Appendix A: Installing and Setting up Sample Data

Sample data is provided to help you use the product. This section provides the installation instructions for the sample data.


Install the Samples

The IBM Cognos samples include an IBM Cognos TM1 cube, and a database you can restore to any of the following database servers:

- IBM DB2
- Oracle
- Microsoft SQL Server

Install in a directory that contains only ASCII characters in the path name. Some servers do not support non-ASCII characters in directory names.

Steps

1. Insert the IBM Cognos samples CD or go to the location where the installation files were downloaded and extracted.
2. Double-click issetup.exe.
3. On the Welcome page, select the language, and click Next.
4. On the IBM License Agreement page, click I accept and click Next.
5. On the Installation Location page, accept or change the default location where IBM Cognos samples will be installed and click Next.
   If an IBM Cognos product was already installed in the default location, you must choose a different location.
6. On the Component Selection page, expand IBM Cognos Business Viewpoint Samples, and select the samples you want to install.
   - If you use an IBM DB2 database, select BVSDB2.
   - If you use an Oracle database, select BVSORA.
   - If you use a Microsoft SQL Server database, select BVSWSQL.
   - If you use IBM Cognos TM1, selectBVSTM1.
7. On the **Shortcut Folder** page, accept or change the default folder where shortcuts to IBM Cognos Business Viewpoint Samples will be installed, and click **Next**.

8. On the **Summary** page, click **Next**.

9. On the **Finish** page, do one or more of the following before clicking **Finish**:
   - View the transfer log file.
   - View the summary error log file.

### Setting Up the Samples

IBM® Cognos® provides sample databases that contain sales information for a fictional company named the Great Outdoors.

### Restore the Sample Databases

To use the sample databases, you must restore backup files. This action re-creates multilingual versions of the Great Outdoors databases.

The following sample databases and associated files are provided.

- For DB2, the database schemas are delivered in a DB2 move file. The files are compressed, and you must extract them before you can restore the databases or schemas.
- For Microsoft® SQL Server the database is delivered as a Microsoft SQL Server backup file.
- For Oracle, it is an Oracle export file (.dmp).

### SQL Server Databases and Files

<table>
<thead>
<tr>
<th>Database or schema description</th>
<th>File name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Great Outdoors sales</td>
<td>GOSALES.zip</td>
</tr>
<tr>
<td>Great Outdoors retailers</td>
<td>GOSALES.zip</td>
</tr>
<tr>
<td>Great Outdoors market research</td>
<td>GOSALES.zip</td>
</tr>
<tr>
<td>Great Outdoors human resources</td>
<td>GOSALES.zip</td>
</tr>
</tbody>
</table>

### Oracle Databases and Files

<table>
<thead>
<tr>
<th>Database or schema description</th>
<th>File name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Great Outdoors sales</td>
<td>GOSALES.dmp.gz</td>
</tr>
<tr>
<td>Great Outdoors retailers</td>
<td>GOSALES.dmp.gz</td>
</tr>
</tbody>
</table>
When restoring the samples databases, ensure that you do the following:

- Give the restored databases the same names as the backup or export file names. The names are case-sensitive.
- Create users with select privileges for tables in multiple schemas.
- Use the UTF-8 character set on the database server.
- Use the UTF-8 character set on the Windows computer that is the Oracle or DB2 client. For DB2, you must set the DB2CODEPAGE environment variable to a value of 1208. For Oracle, you must set the NLS_LANG environment variable to a value that is specific to a region. For example, set NLS_LANG for Americas to American_America.UTF8.
- Have sufficient disk space available in the target location. Reserve 150MB for the GO Sales data (four schemas).

**Oracle Considerations**

To create foreign key constraints in tables that reference different schemas, you must run gs_or_modify.sql, found in the same folder as the .dmp files.

**Microsoft SQL Server Considerations**

If you restore the Microsoft® SQL Server backup files, you must use Microsoft SQL Server 2000 or Microsoft SQL Server 2005. Ensure that TCP/IP connectivity is used for the SQL server.

**DB2 Considerations**

Before you restore the Great Outdoors schemas contained in the DB2 move file on UNIX or Windows, extract the DB2 move file. On UNIX, extract the DB2 move file using the `gnutar -xcvf` command.
DB2\_move\_filename or tar \-xcvf DB2\_move\_filename command. If you use WinZip to extract the DB2 move file on Windows, ensure that the TAR file smart CR/LF conversion option is not selected.

After extracting the DB2 move file, restore the schemas to a database named GS\_DB.

To add views, constraints, user privileges, and stored procedures to GS\_DB, prepare and run the gs\_db\_modify files included with the samples in the following order:

- Update the user name and password at the top of the gs\_db\_modify.sql and save it.
- Execute gs\_db\_modify.bat

**Steps to Restore the Database Files**

1. On the computer where you installed the samples, go to the database directory located in install\_location/webcontent/samples/datasources directory.
2. If required, copy the backup files for the samples databases to your database backup directory.
3. Restore the samples databases using your database management tool.

**Tips**

- For SQL backup files, restore the database from a device, and ensure that the restore locations are correct for the .ldf and .mdf database files. For more information, see the Microsoft SQL Server documentation or the IBM Cognos Knowledge Base on the IBM Cognos Customer Service Center (http://www.ibm.com/software/data/support/cognos_crc.html).

- For DB2, when you create the GS\_DB database, create a buffer pool with a page size of 16 KB and an associated tablespace.

4. For each database, create at least one user who has select permissions for all the tables in the restored databases.

You can now use this data. For more information on using the sample data, see the IBM Cognos Business Viewpoint Client User Guide.

**Set Up the IBM Cognos TM1 Samples**

A sample cube is provided for use with IBM® Cognos® Business Viewpoint and IBM Cognos TM1®.

**Steps**

1. Go to the install\_location/webcontent\samples\datasources\cubes\TM1 directory.
2. Expand the file named greatoutdoors.zip.
   
   Expanding the files creates three folders in the location where you unzipped the file: DataFiles, LogFiles, and SourceFiles.
3. Go to the install\_location/webcontent\samples\datasources\cubes\TM1\GreatOutdoors\DataFiles directory.
4. Open the file named tm1s.cfg in a text editor.
5. Change the DataBaseDirectory and LoggingDirectory paths to the location where you installed the sample files.
   For example, change DataBaseDirectory to \install\location\webcontent\samples\datasources\cubes\TM1\GreatOutdoors\DataFiles and change LoggingDirectory to \install\location\webcontent\samples\datasources\cubes\TM1\GreatOutdoors\LogFiles.

6. Save and close the file.

7. In the \install\location\webcontent\samples\datasources\cubes\TM1\GreatOutdoors\DataFiles directory, right-click the GreatOutdoors shortcut, and click Properties.

8. In the Target box, change the path to both the tm1s.exe and the sample data location.
   For example, if you installed IBM Cognos TM1 to the default location and you installed the sample data to C:\SampleData, the target value would look like this:
   "C:\Program Files\Cognos\TM1\bin\tm1s.exe" -z "C:\SampleData\webcontent\samples\datasources\cubes\TM1\GreatOutdoors\DataFiles"

9. In the Start In box, ensure that you have the correct path to your IBM Cognos TM1 installation.

10. Double-click the GreatOutdoors shortcut.
    If you have any errors or the server will not start, check the values you entered in the tm1s.cfg file and the paths in the GreatOutdoors shortcut.

11. Launch IBM Cognos TM1 Architect.
    A server named greatoutdoors server should appear.

12. Double-click the greatoutdoors server.

13. When prompted, enter admin for the UserName and leave Password blank.

For more information on using the sample data, see the IBM Cognos Business Viewpoint Client User Guide.

### About The Great Outdoors Group of Companies

To make designing examples faster, especially financial examples, some general information about The Great Outdoors Company is useful.

Revenue for The Great Outdoors Company comes from corporate stores and from franchise operations. The revenues are consolidated from the wholly-owned subsidiaries. There are six distinct organizations, each with its own departments and sales branches. Five of these are regionally-based companies.

The sixth company, GO Accessories
- has its own collection of products, differentiated from the other GO companies by brand, name, price, color and size
- sells from a single branch to all regions and retailers
functions both as an operating company based in Geneva, and as a part owner of the three GO subsidiaries in Europe.

The diagram below illustrates the consolidated corporate structure, including the percentage changes in ownership for GO Central Europe, and shows the reporting currency and GL prefix for each subsidiary.

Each corporation has the same departmental structure and the same GL structure, shown in the table below. Divisions may not report in the same currencies. For example, the Americas subsidiary reports in US dollars, but the Corporate division local currency is Canadian dollars, and the Operations division local currency is pesos.

<table>
<thead>
<tr>
<th>Division (GL)</th>
<th>Department (GL)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Corporate (1700)</td>
<td>Sales (1720)</td>
</tr>
<tr>
<td></td>
<td>Marketing (1750)</td>
</tr>
<tr>
<td></td>
<td>IS&amp;T (1760)</td>
</tr>
<tr>
<td></td>
<td>Human Resources (1730)</td>
</tr>
<tr>
<td></td>
<td>Finance (1740)</td>
</tr>
<tr>
<td></td>
<td>Procurement (1710)</td>
</tr>
<tr>
<td>Operations (1800)</td>
<td>Production and Distribution (1820)</td>
</tr>
</tbody>
</table>
Each corporation has a complete chart of accounts. Most of the accounts, such as those under non-personnel expenses, are at the department level, and contain only summary amounts. For example, although each marketing department has expenses, the cost is unspecified at the transaction level where marketing promotions occur.

### Employees

The Great Outdoors data contains a full list of employees in all divisions, departments, and locations. Data is available for reports about bonuses (Global Bonus report) and sales commissions (Sales Commissions for Central Europe report), training (Employee Training by Year report), and performance reviews and employee satisfaction surveys (Employee Satisfaction 2006).

### Sales and Marketing

Overall, the GO companies have experienced solid growth across most product lines (Sales Growth Year Over Year), in all regions (Revenue by GO Subsidiary 2005), because of factors like an increase in repeat business and new or improved products, such as the high margin sunglasses product line. In the product lines sold by the five regional companies (all but GO Accessories) promotions have had mixed success (Promotion Success by Campaign, Bundle and Quarter).

### Customer Surveys

The data also contains information from customer surveys. For example, the product line that includes bug spray, sun screen, and so on has not been successful (Product Satisfaction - Outdoor Protection 2005) and a source of retailer dissatisfaction may be the level of customer service rather than the returns (Customer Returns and Satisfaction).

### Sales Outlets

Revenue from the corporate outlets is available at the transaction level. Metrics about retailers show that the number of new retail outlets has dropped over the time period covered by this data. GO Accessories sells worldwide, and sells only accessories. Transaction data for GO Accessories is the primary source for analysis of product by brand, color and size. The other five subsidiaries in the group of companies are regional and sell all product lines for retailers in their region.
Appendix A: Installing and Setting up Sample Data
Appendix B: Setting up an unattended installation and configuration

Set up an unattended installation and configuration to do the following:

- Install an identical configuration across several computers on your network.
- Automate the installation and configuration process by specifying options and settings for users.
- Install and configure components in a UNIX® or Linux® operating system that does not have XWindows.

Before you set up an unattended installation and configuration, ensure that all the system requirements and prerequisites are met, and that all your required software is installed and configured.

To set up an unattended installation and configuration, perform the following tasks:

- Configure a transfer specification file (.ats) to specify installation options.
- Run the installation tool in silent mode.
- Use a pre-configured configuration file from another computer.
- Run the configuration tool in silent mode.

After you complete these tasks, ensure that the IBM® Cognos® Business Viewpoint installation directory on all computers is protected from unauthorized or inappropriate access. Then you will be ready to use IBM Cognos Business Viewpoint.

Setting up an unattended installation

Use a transfer specification file (.ats) to copy IBM® Cognos® Business Viewpoint components to your computer without being prompted for information.

By default, each time you install IBM Cognos Business Viewpoint using the installation wizard, the options you select are recorded in a transfer specification file. Therefore, if you already installed IBM Cognos Business Viewpoint on a sample computer, you can use the generated transfer specification file as a template for unattended installations on different computers.

If you do not use the installation wizard to install components, you can use the default transfer specification file (response.ats) that is available on the CD. You must modify the response.ats file for your environment before you can use it for an unattended installation.

You can check if the unattended installation was successful by checking the return status. A value of zero (0) indicates success, and all other values indicate that an error occurred.

Steps using a file generated by an installation on another computer

1. Use the installation wizard to install IBM Cognos Business Viewpoint on one computer.
Appendix B: Setting up an unattended installation and configuration

2. Go to `installation_location\instlog`.

3. Locate the transfer specification file (.ats) that was generated.
   The filename format is `ts-BV-version-yyyyymmdd_hhmm.ats`.

4. Copy the transfer specification file to the computer where you plan to install IBM Cognos Business Viewpoint.

5. On the computer where you plan to install the software, insert the appropriate CD and copy the contents of the CD to your computer.

6. Use a text editor to open the transfer specification file that you copied.

7. In the License Agreement section, change the ACCEPTED= property to `y`.

8. Save the transfer specification file in the directory where you copied the contents of the installation CD.

9. Install IBM Cognos Business Viewpoint:
   - On the Microsoft® Windows® operating system, open a Command Prompt window, and change to the win32 directory where you copied the contents of the CD, and then type the following command, where `location` is the directory where you copied `filename`, the transfer specification file:
     ```
     issetup -s location/filename.ats
     ```
   - On the UNIX® or Linux® operating system, change to the directory where you copied the contents of the CD, and in the directory for your operating system, type the following command, where `location` is where you copied `filename`, the transfer specification file:
     ```
     /issetup -s location/filename.ats
     ```

   If a return status other than zero (0) is returned, check the log files for error messages. Errors are recorded in the `Business_Viewpoint_installation_location\instlog` directory in a summary error log file. The filename format is `tl-BV-version-yyyyymmdd-hhmm_summary-error.txt`.

   If errors occur before sufficient initialization occurs, log messages are sent to a log file in the Temp directory. The filename format is `tl-BV-version-yyyyymmdd-hhmm.txt`.

   Also ensure that the installation directory is protected from unauthorized or inappropriate access.

   After all errors are resolved, you can set up an unattended configuration. For more information, see "Setting up an unattended configuration" (p. 69).

**Steps using the response.ats file**

1. On the target computer, insert the CD and copy the contents to your computer.

2. Go to the operating system directory and open the response.ats file in a text editor.
   Each section in the response.ats file corresponds to a dialog box in the installation wizard.

3. In the section named License Agreement, change the ACCEPTED= property to `y`. 
4. Type the installation location of the program files for IBM Cognos Business Viewpoint Server in APPDIR=location.
   There should be no space on either side of the equal sign (=).

5. For IBM Cognos Business Viewpoint Server, in the section named [Component List], next to each component, do one of the following:
   • To install the component, type 1
   • To not install the component, type 0

6. For a Microsoft® Windows® installation, for the APPFOLDER= property, type the name of the Start menu folder that contains your program shortcuts.
   Tip: To ensure that the shortcut folder is visible to all users, type 1 for the ALLUSERS_FLAG= property.

7. For the install information in the [Install Conditions] section, do one of the following:
   • To specify that the condition is true, type 1
   • To specify that the condition is false, type 0

8. Save the response.ats file to a local directory after you make the necessary changes.

9. Go to the operating system directory.

10. At the command prompt, type the following command, where location is the directory where you copied response.ats:
    • On the Microsoft Windows operating system,
      `isssetup -s location/response.ats`
    • On the UNIX® or Linux® operating system,
      `./isssetup -s location/response.ats`

    If a return status other than zero (0) is returned, check the log files for error messages. Errors are recorded in the install_location\instlog directory in a summary error log file. The filename format is tl-BV-version-yyyyymmdd-hhmm_summary-error.txt.

    If errors occur before sufficient initialization occurs, log messages are sent to a log file in the Temp directory. The filename format is tl-BV-version-yyyyymmdd-hhmm.txt.

    Also ensure that the installation directory is protected from unauthorized or inappropriate access.

    After all errors are resolved, you can set up an unattended configuration.

### Setting up an unattended configuration

Before you set up an unattended configuration, you must export a configuration from another computer that has IBM® Cognos® Business Viewpoint Server installed. You can then run IBM Cognos Configuration in silent mode.
The exported configuration contains the properties of IBM Cognos Business Viewpoint Server that you installed on the source computer.

Ensure that the configuration settings on the local computer are appropriate to use to configure another IBM Cognos Business Viewpoint Server computer with the same installed components.

**Steps**

1. In IBM Cognos Configuration, click **File > Export as**.

2. To export the current configuration to a different folder, in the **Look in** box, locate and open the folder.
   
   Ensure that the folder is protected from unauthorized or inappropriate access.

3. In the **File name** box, type a name for the configuration file.

4. Click **Save**.

5. Copy the exported configuration file from the source computer or network location to the `installation_location/configuration` directory on the computer where you plan to do an unattended configuration.

6. Rename the file to `cogstartup.xml`.

7. If you changed the global configuration on the source computer, copy the `coglocale.xml` file from the source computer to the `installation_location/configuration` directory on the computer where you plan to do an unattended configuration.

8. Go to `installation_location/bin`.

9. Type the configuration command:
   
   - On the Microsoft® Windows® operating system, type
     
     `cogconfig.bat -s`

   - On the UNIX® or Linux® operating system, type
     
     `./cogconfig.sh -s`

   **Tip:** To view log messages that were generated during an unattended configuration, see the `cogconfig_response.csv` file in the `Business_Viewpoint_installation_location/logs` directory.

   You can check if the unattended configuration was successful by checking the return status. A value of zero (0) indicates success, and all other values indicate an error.

IBM Cognos Configuration applies the configuration settings that are specified in the local copy of `cogstartup.xml`, encrypts credentials, generates digital certificates, and starts the Tomcat server.

---

### Setting up an unattended uninstallation

You can set up an unattended installation and configuration of IBM® Cognos® Business Viewpoint Server by doing the following:

- Automate the removal of components on several computers that have the same components.
• Remove components in a UNIX® or Linux® operating system that does not have XWindows.

Steps
1. Go to Business_Viewpoint_installation_location/instlog.
2. In a text editor, open the transfer specification .ats file for the product.
   The filename format of the transfer specification .ats file is ts-BV-version-yyyyymmdd_hhmm.ats
   If you have more than one .ats file, you only need to edit one of the .ats files.
3. In the section named [Component List], specify the components to remove by doing one of the following:
   • To remove the component, type 1
   • To leave the component installed, type 0
4. Save and close the file.
5. Go to the operating system directory.
6. At the command prompt, type the following command, where filename is the name of the transfer specification .ats file that you edited:
   • On the Microsoft® Windows® operating system,
     \uninst -u -s Business_Viewpoint_installation_location/instlog/filename.ats
   • On the UNIX or Linux operating system,
     ./uninst -u -s Business_Viewpoint_installation_location/instlog/filename.ats
Appendix B: Setting up an unattended installation and configuration
Appendix C: Troubleshooting

Use this troubleshooting information to help you solve specific problems that you may encounter during or after the installation of IBM® Cognos® Business Viewpoint Server.

Problems are characterized by their symptoms. Each symptom can be traced to one or more causes by using specific troubleshooting tools and techniques. After being identified, each problem can be fixed by implementing a series of actions.

When you are troubleshooting, log files can help you.

When you cannot resolve a problem, the final resource is your technical support representative. To analyze a problem, your technical support representative requires information about the situation and the symptoms that you are experiencing. To help isolate the problem, collect the necessary data before you contact your representative.

Log files

Log files can help you troubleshoot problems by recording the activities that take place when you work with a product. Operations performed in IBM® Cognos® Business Viewpoint are recorded in various log files for tracking purposes. For example, if you experienced problems installing IBM Cognos Business Viewpoint Server, consult the transfer log file to learn what activities the installation wizard performed while transferring files.

When troubleshooting, the following files can assist you.

**IBM Cognos Business Viewpoint Server log file**
The default IBM Cognos log file, or other log files that you configure to receive log messages from the log server, record information after you start the IBM Cognos service. If you configured another destination for log messages, check the appropriate file or database.

Some log messages indicate problems. Most messages provide information only, but others can help you to diagnose problems in your environment.

Location of the file: Business_Viewpoint_Server_installation_location\logs directory

File name: bvserver.log

**Transfer log file**
This file records the activities that the installation wizard performed while transferring files.

Location of the file: Business_Viewpoint_Server_installation_location\instlog directory

File name contains: product name, version, build number, and time stamp

The following is an example of the file name format: tl-MDM-8.4-128.23-20090626_1653.txt
Appendix C: Troubleshooting

**Transfer summary-error log file**
This file records the components you installed, disk space information, the selections you made in the transfer dialogs, and any errors the installation wizard encountered while transferring components.

Location of the file: *Business_Viewpoint_Server_installation_location\instlog* directory
File name contains: product name, version, build number, time stamp, and "summary_error"

The following is an example of the file name format: *tl-MDM-8.4-128.23-20090626_1653_summary_error.txt*

**Startup configuration file**
This file records your configuration choices each time you save your property settings. The file name is cogstartup.xml. If you are unable to save your configuration, or are having problems you can revert to a previously saved configuration file.

Location of the file: *Business_Viewpoint_Server_installation_location\configuration* directory
File name: cogstartup.xml

**Startup configuration lock file**
This file is created each time you open IBM Cognos Configuration. It prevents you from opening more than one IBM Cognos Configuration window. If you experience problems opening IBM Cognos Configuration, look for the cogstartup.lock file in the configuration directory. If the file exists and IBM Cognos Configuration is not open, it means that IBM Cognos Configuration did not shut down properly the last time you used it. Delete the lock file and then open IBM Cognos Configuration.

Location of the file: *Business_Viewpoint_Server_installation_location\configuration* directory
File name: cogstartup.lock

**Locale configuration file**
This file records the configuration choices you make in IBM Cognos Configuration for product and content locales, locale mapping, and currency support. If you experience problems with language support in the user interface or in reports, use the locale configuration file to track your changes.

Location of the file: *Business_Viewpoint_Server_installation_location\configuration* directory
File name: coglocale.xml

**Uninstallation log file**
This file records the activities that the Uninstall wizard performed while uninstalling files. You can use the log file to troubleshoot problems related to uninstalling IBM Cognos Business Viewpoint Server.

Location of the file: *Business_Viewpoint_Server_installation_location\unstlog* directory
File name contains: timestamp and isconfig-UNINSTALL_PACKAGE.log
Cannot initialize a DB2 database

When you start the Tomcat Server, the IBM® DB2® database initialization fails. The IBM Cognos Business Viewpoint file, bvserver.log, reports the following message:

```
SQLSTATE=54048, sqlcode : -1585 A system temporary table space with sufficient page size does not EXIST
```

This message displays because a System temporary tablespace was not created.

In DB2, ensure that you create a tablespace for each of the following types of data:

- Regular
- System temporary
- User temporary

Cannot initialize the SQL Server database

When you start the Tomcat server, the Microsoft® SQL Server database initialization fails. The IBM Cognos Business Viewpoint file, bvserver.log, reports the following message:

```
com.cognos.mdm.common.utility.MDMRuntimeException:Database Installation failed
java.sql.SQLException: Login failed for user 'bvsuser'. The user is not associated with a trusted SQL Server connection.
```

This message displays because the SQL server was not configured to use Mixed Mode authentication.

To fix the problem, start Microsoft SQL Server Configuration Manager and set authentication to SQL Server and Windows Authentication mode.

Cannot initialize a database that was configured using SQL Express

You configured the Microsoft® SQL Server database using Microsoft SQL Express. When you start the Tomcat server, the SQL database initialization fails. The IBM Cognos Business Viewpoint file, bvserver.log, reports the following message:

```
Database Installation failed.java.sql.SQLException: Unknown server host name 'server_name\\SQLEXPRESS'
```

This message displays because the default SQL Express location, `server_name\SQLEXPRESS`, was specified in Cognos Configuration as the database server. However, `\SQLEXPRESS` should not be appended to the server name.

To fix the problem, do the following:

1. Start Cognos Configuration.
2. In the Explorer window, click Data Access > Business Viewpoint Repository > `repository_name`.
3. In the Database server with Port number or instance name, type
4. Restart the Tomcat server.

**Unable to read the contents of the keystore**

When you start the Tomcat server, the database and server initialization fails. The IBM Cognos Business Viewpoint file, bvserver.log, reports the following message:

```
utility.MDMRuntimeException: Failed to determine configured database type.
```

Then this message displays:

```
com.cognos.cclcfgapi.CCLConfigurationException: CAM-CRP-1064 Unable to process the PKCS #7 data because of an internal error. Unable to read the contents of the keystore 'C:/Program Files/IBM Cognos/BusinessViewpoint/configuration/csk/CSKKeystore'. Reason: java.io.IOException: com.sun.crypto.provider.SealedObjectForKeyProtector
```

These error messages display because the following events took place:

1. IBM® Cognos® Business Viewpoint Server was configured while the JAVA_HOME environment variable was pointing to the Sun version of Java™ Runtime Environment (JRE) or JDK. As a result, the product configuration was encrypted by the Sun JRE.

2. JAVA_HOME was removed from your environment.

3. Because JAVA_HOME was no longer set, IBM Cognos Business Viewpoint used the IBM version of JRE that was bundled with IBM Cognos Business Viewpoint Server.

4. The IBM JRE could not decrypt the product configuration that was originally encrypted by the Sun JRE.

To fix the problem, choose one of the following options:

- Restore JAVA_HOME back to its original value, pointing to the Sun version of JRE or JDK.
- Verify that JAVA_HOME is not set. Then reinstall IBM Cognos Business Viewpoint Server and use the IBM JRE.

**Java out-of-memory exceptions**

When the server is processing information, java out-of-memory exceptions display.

To solve this problem, increase the amount of memory that is allocated for Java™.

**Steps**

1. Start IBM® Cognos® Configuration.

2. Click **Actions > Stop**.
   
   The IBM Cognos Business Viewpoint Windows service stops.

3. Open a DOS window and go to `installation_location\bin`
4. Type the following:
   
   \texttt{cmd /c "bbservice.bat uninstall"}
   
   The Microsoft® Windows® service is uninstalled.

5. Open the Windows Services dialog box and verify that the service was removed.

6. Open the file \texttt{installation_location\bin\bbservice.bat} in a text editor.

7. Find the following section:
   
   \texttt{rem Set extra JVM parameters}
   
   \texttt{rem "for machines with 1GB RAM"}
   
   \texttt{set EXTRA_JVM_OPTIONS=-Xmx768m;-XX:MaxNewSize=384m;-XX:NewSize=192m;-XX:MaxPermSize=128m}
   
   \texttt{rem "for machines with 2GB RAM"}
   
   \texttt{rem set EXTRA_JVM_OPTIONS=-Xmx1152m;-XX:MaxNewSize=576m;-XX:NewSize=288m;-XX:MaxPermSize=128m}
   
   \texttt{rem "for machines with 3GB RAM"}
   
   \texttt{rem set EXTRA_JVM_OPTIONS=-Xmx1536m;-XX:MaxNewSize=768m;-XX:NewSize=384m;-XX:MaxPermSize=128m}

8. Comment out the 1GB line.

9. Uncomment either the 2GB or the 3GB line.

10. Save the file.

11. Start the service in IBM Cognos Configuration.

**Performance issues with an Oracle database**

You find that IBM® Cognos® Business Viewpoint Studio has slowed when opening objects. You need to ensure that statistics are current.

**Do the following, replacing BVSUSER with the actual user name.**

1. In Oracle SQL*Plus, login as the system user.

2. To ensure all tables have monitoring enabled, execute the following SQL:
   
   \texttt{SELECT TABLE_NAME, MONITORING}
   
   \texttt{FROM dba_tables}
   
   \texttt{WHERE owner = 'BVSUSER'}
   
   \texttt{AND MONITORING = 'NO'}
   
   \texttt{ORDER BY 1}
   
   If results are returned, see the Oracle documentation for enabling table monitoring for each returned table.

3. To ensure that the statistics are current, execute the following SQL command:
   
   \texttt{SELECT TABLE_NAME, to_char(LAST_ANALYZED,'HH24:MI:SS DD-MM-YYYY')}
WHERE owner = 'BVSUSER'
AND last_analyzed < systimestamp
ORDER BY 1

4. If the result is not empty execute the following SQL:

EXECUTE dbms_stats.gather_schema_stats( ownname=>'BVSUSER', options=>'GATHER', no_invalidate=>FALSE, cascade=>TRUE );

This will force statistics for all tables in the 'BVSUSER' schema to be updated.

IBM Cognos Business Viewpoint Service is not connected to the database on the same computer

When IBM® Cognos® Business Viewpoint Server and its database are installed on the same computer and the computer is rebooted, IBM Cognos Business Viewpoint does not connect to the database.

In most scenarios, the database runs on a different computer than IBM Cognos Business Viewpoint Server. However, if they are installed on the same computer, on startup the IBM Cognos Business Viewpoint service may start before the database service.

To fix this problem, create a dependency in your computer’s startup routine so that the IBM Cognos Business Viewpoint service depends on the database service. The dependency ensures that the database service starts before the IBM Cognos Business Viewpoint service starts. To do this, you must edit the Microsoft® Windows® registry. For more information, see the Microsoft Web site.

Important: When you edit the registry, make sure that you follow instructions carefully. If you edit the registry incorrectly, serious problems can occur.

An alternate solution is to change the startup type of the IBM Cognos Business Viewpoint service from Automatic to Manual. If you choose this option, you must manually start the IBM Cognos Business Viewpoint service each time the computer is rebooted.

IBM Cognos Business Viewpoint Service does not start because a Windows Service is still running

When you try to start the IBM® Cognos® Business Viewpoint Service in IBM Cognos Configuration, the service fails to start. You fix the configuration error that caused this problem and restart the service in IBM Cognos Configuration. The service again fails to start because the Microsoft® Windows® service for IBM Cognos Business Viewpoint is still running.

The IBM Cognos Business Viewpoint file, bvserver.log, reports the following message:

com.cognos.mdm.common.utility.MDMRuntimeException: Trying to access the configuration before initialization is completed.

To fix this problem, do the following:

- Stop the IBM Cognos Business Viewpoint Windows Service in the Control Panel > Services Console.
- Restart the service in IBM Cognos Configuration.
Appendix D: Keyboard Shortcuts in the Installation Wizard

Keyboard shortcuts, or shortcut keys, provide you with an easier and often faster method of navigating and using software.

You can use the keyboard instead of the mouse for some actions.

Keyboard shortcuts are usually accessed by using the Alt, Ctrl, or Shift keys in combination with other keys. For example, Alt+S indicates that you press and hold the Alt key and then press the S key.

The following table lists the keyboard shortcuts that you can use to perform some of the main tasks in the installation wizard on the Windows® operating system.

<table>
<thead>
<tr>
<th>To do this</th>
<th>Press</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move to the next field on a page</td>
<td>Tab</td>
</tr>
<tr>
<td>Return to the previous field on a page</td>
<td>Shift+Tab</td>
</tr>
<tr>
<td>Close the installation wizard</td>
<td>Alt+F4</td>
</tr>
<tr>
<td>Move to the next configuration step</td>
<td>Alt+N</td>
</tr>
<tr>
<td>Return to the previous configuration step</td>
<td>Alt+B</td>
</tr>
<tr>
<td>Move to the next selection in a list</td>
<td>Down arrow</td>
</tr>
<tr>
<td>Move to the previous selection in a list</td>
<td>Up arrow</td>
</tr>
</tbody>
</table>

The following table lists the keyboard shortcuts you can use to perform some of the main tasks in the installation wizard on the UNIX® or Linux® operating system.

<table>
<thead>
<tr>
<th>To do this</th>
<th>Press</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move to the next field on a page</td>
<td>Tab</td>
</tr>
<tr>
<td>Return to the previous field on a page</td>
<td>Shift+Tab</td>
</tr>
<tr>
<td>Close the installation wizard</td>
<td>Alt+F4</td>
</tr>
<tr>
<td>Move to the next selection in a list</td>
<td>Down arrow</td>
</tr>
</tbody>
</table>
Appendix D: Keyboard Shortcuts in the Installation Wizard

The following table lists the keyboard shortcuts you can use to perform some of the main tasks in the License Agreement page of the installation wizard.

<table>
<thead>
<tr>
<th>To do this</th>
<th>Press</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move to the previous selection in a list</td>
<td>Up arrow</td>
</tr>
<tr>
<td>Accept the license agreement</td>
<td>Alt+A</td>
</tr>
<tr>
<td>Decline the license agreement</td>
<td>Alt+D</td>
</tr>
<tr>
<td>Quit the installation wizard</td>
<td>Alt+x</td>
</tr>
</tbody>
</table>
Index

A
Active Directory Server
  advanced properties, 38
  authenticating in multiple domains, 38
  using for authentication, 37
  with an LDAP namespace, 41
active scripting
  enabling in Web browsers, 26
aggregating
  samples and time dimensions, 65
application file, 51
application servers
  configuring, 52
application tier components
  configuration requirements, 16
  installing on separate computer, 15
audience of document, 7
authentication
  Active Directory Server, 37
  deleting namespaces, 45
  domain trees for Active Directory Server, 38
  LDAP, 39, 40
  LDAP using Active Directory Server, 41
  NTLM, 44
  testing namespaces, 45

B
backing up
  Business Viewpoint information, 48
  backing up data, 56
backup data, 56
Bind user DN and password property
  special characters for LDAP namespace, 39
Business Viewpoint Server
  component description, 9
  components, 9
  distribution options, 13
Business Viewpoint Studio
  component description, 9

C
chase_referral files, 38
cogstartup.lock file, 74
components, 9
  application tier components, 15, 16
  Business Viewpoint Server, 9
  Business Viewpoint Studio, 9
  gateways, 9, 14
  IBM Cognos Configuration, 9
  IBM Cognos Connection, 10
  installing on one computer, 13
configuration
  backing up, 48
  lock file, 74
  unable to open IBM Cognos Configuration, 74
  unattended, 69
  workflows, 11
configuration files
  exporting, 69
configuring
  Active Directory namespace, 38
  application server properties, 52
  LDAP namespace, 40
  LDAP namespace for Active Directory Server, 41
  mail server accounts, 34
  NTLM namespace, 44
  unattended, 69
  Web browsers, 26
cookies
  enabling in Web browsers, 26
cryptographic keys
  backing up and deleting, 48

data
  backing up, 56
  IBM Cognos samples, 60
  restoring, 57
databases
  Business Viewpoint repository, 21
Index

IBM Cognos samples, 60
Data Manager Runtime, 10
DB2
  repository, 21
description of product, 7, 73
distribution options, 13
domains
  Active Directory Server domain trees, 38
E
email
  configuring mail server accounts, 34
environment
  setting up, 19
environments
  supported, 19
environment variables
  Business Viewpoint repository, 21
  setting for application servers, 49
error message
  installing, 78
exporting
  configuration files, 69
external identity mapping property
  editing for an LDAP namespace, 43
External identity mapping property
  special characters for LDAP namespace, 39
F
Firefox
  browser settings, 26
G
gateways
  component description, 9
  configuration requirements, 15
  installing on separate computer, 14
Great Outdoors, See IBM Cognos samples
Great Outdoors samples, 59
I
IBM Cognos
  samples, 60
IBM Cognos Business Viewpoint
  system requirements, 20
IBM Cognos Configuration
  component description, 9
  problems opening, 74
  unattended mode, 69
IBM Cognos Connection
  component description, 10
IBM Cognos samples, 60
IBM Cognos TM1, 17
IBM DB2
  repository, 21
IBM WebSphere
  setting up, 47
installation
  workflows, 11
installing
  error message, 78
  unattended install, 67
  using transfer specification files (.ats), 67
Internet Explorer
  browser settings, 26
J
Java scripts
  enabling in Web browsers, 26
K
keyboard shortcuts, 79
L
LDAP
  Active Directory Server, 41
  configuring a namespace, 40
  editing the External identity mapping property, 43
  using for authentication, 39
load balancing
  setting, 15
log files, 73
  Business Viewpoint Server, 73
  locale configuration, 74
  startup configuration, 74
  transfer, 73
  transfer summary-error, 74
  uninstallation, 74
logging databases
  creating, 21
M
mail server accounts
  configuring, 34
Microsoft SQL Server
  repository, 23
migrating to different environment, 56, 57
moving data, 17
multi_domain_tree, 38

N
namespaces
  deleting, 45
  testing, 45
NTLM, 44
  configuring, 44
NTLM, See Also Windows native security (NTLM)

O
optimizing
  system, 55
Oracle
  repository, 24

P
performance, 77
preparing to install, 19
problems opening IBM Cognos Configuration, 74
properties
  configuring for application server, 52
purpose of document, 7, 73

R
release notes
  reviewing before installing, 19
repository
  creating, 21
  IBM DB2, 21
  Microsoft SQL Server, 23
  Oracle, 24
response.ats file, 67
restoring
  samples databases, 60
restoring data, 56, 57
reviewing release notes before installing, 19

S
samples
  general employee information, 65
  general financial information, 63
  general sales and marketing information, 65
  Great Outdoors, 59
  Great Outdoors company structure, 63
  restoring samples databases, 60
setting up, 60
security
  settings for Web browsers, 20
service
  not starting, 78
setting up
  samples, 60
shortcut keys, 79
silent uninstallation, 70
special characters
  in LDAP namespace properties, 39
starting
  services, 78
startup
  configuration lock file, 74
supported environments, 19
system
  optimizing, 55
system requirements, 20

T
TM1, 17

U
unable to open IBM Cognos Configuration, 74
unattended installation, 67, 70
uninstalling
  unattended, 70
upgrading, 56, 57
User lookup property
  special characters for LDAP namespace, 39

W
Web browsers
  configuring, 26
  security settings, 20
WebSphere
  application server, 52
Index

setting up, 47
Windows native security (NTLM)
  using for authentication, 44
workflows
  installation and configuration, 11